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Activating the FIs  Back to Top 
 
Step 1:  After initialization is complete, select "FI Select" pull down menu. 
 
Step 2:  Click on desired FI. 
 
Step 3:  Repeat steps 1 and 2 for further needed FIs. 
 
 
Auto Activating the FIs  Back to Top 
 
Step 1:  From the Tools pull down menu off the system top main menu, select 
User Utilities.       
 
Step 2:  From the “User Utils” window, scroll down to the “Auto Activate FI’s” 
option and double click. 
 
Step 3:  Select the FI’s you wish to have auto activated every time the system 
initializes.  If the operator selects the “SYS” FI, the system will begin auto-
initialize every time it is booted. Click save. 
 

 
 
 
 
Restart DB Query Ops  Back to Top 
 
Step 1:  From the Tools pull down menu off the system main menu, select User 
Utilities. 
 
Step 2:  From the “User Utilities” window, double-click the “Restart Database 
Query Operations”. 
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Step 3:  Follow prompts from system to complete this operation. 
 
Step 4:  Re-open Database Query Operations when you have restarted the 
process. 
 
 
File Browser Operations   Back to Top 
 
Step 1: From the Tools Pulldown menu, select the User Utilities option. 
 
Step 2: Double-click the "File Browser" icon within the User Utils window.  
(Opens the File Browser window.) 
 
Step 3:  The File Browser window contains a list of Devices and Folders that are 
available for the user to access.  These devices and folders are for:   

A) Devices:  Floppy Disk – allows access to the floppy device on the 
system.   CDROM – allows access to the CDROM device.   
B) Folders:  Inbound Msg's – is the folder where inbound messages are 
stored prior to parsing.  Outbound Msg's – is the folder where outgoing 
messages are stored prior to being released from the system.Map 
Overlays – overlays created by the user and saved are stored in this 
folder.  Comm Router Files – is the storage area for communications 
related files and should not be modified by the user.  Personal Files – is 
the "/users/<username>/office_products" directory of the user.  Any files 
saved by the user from the system tools (with the exception of Applix and 
Office products) will be stored here.  Trash Can – is a temporary storage 
area of files that are awaiting permanent deletion. 

 
Step 4:  Double click on the Personal Files folder.  This will open a list of files that 
have been created/saved by the user. 
 
Step 5:  Double click on a file that has the "Typing paper" shaped icon.  This will 
open the file into the text editor window.  Explain how this program will allow 
basic text editing/viewing of user files. 
 
Step 6:  Exit or close the text editor window. 
 
Step 7:  Move the Personal Files window to the side, and double click on the 
Trash Can icon within the File Browser window. 
 
Step 8:  Click and hold on a file within the Personal Files window, and drag/drop 
the file into the Trash Can window.   Explain how this is used to move files 
between folders and devices.  NOTE:  Files may also be drag/dropped onto the 
printer icon (on the CDE) to allow for printing of the file(s). 
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Step 9:  Drag/drop the file from step 8 back into the Personal Files window. 
 
Step 10:  Single Click on any file in the Personal Files window.  Select the 
“Selected” pull down menu from the menu bar in the Personal Files window.  
 
Step 11:  Exit the File browser by selecting the File pull down and “exit”  
 
 
Change Nickname/Codeword  Back to Top 
 
Step 1: From the COM FI top-level menu, scroll down and select "Change 
Nickname/Codeword". 
 
Step 2:  Click on the Exercise Nickname Entry field. 
 
Step 3:  Enter a new nickname in the text box (no underscore). 
 
Step 4:  Click Add. 
 
Step 5:  Highlight the nickname on the Nicknames List. 
 
Step 6:  Click the "Make Current" button.  The exercise nickname entry field will 
be filled in with the new value. 
 
Step 7:  Select done to exit. 
 
 
Accessing Windows Products   Back to Top 
 
Step 1: From the Tools pull down menu off the system main menu, select Office 
Products.  This will open the Office Products window. 
 
Step 2:  In the Office Products window, double-click the “COE Office Products” 
icon.  The SUN/PCI window will open and begin booting Windows NT 4.0. 
 
Step 3:  Push Ctrl+Alt+Del when asked. 
 
Step 4:  Type in "asasuser" the User name block and “asasuser” in the Password 
block. 
 
Step 5:  Once Windows NT has opened up, click the "START" button on the 
lower left hand corner and scroll up to "Programs."   
 
Step 6:  Select the Word icon from the toolbar.  MS Word will open. 
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Create and Maintain Address Resumes  Back to Top 
 
Step 1:  Activate the COM FI. 
 
Step 2:  Double-click "Address Maintenance". 
 
Step 3: The COM-ADDRESS MAINTENANCE window will open. 
 
Step 4:  TO EDIT AN ADDRESS (ONLY);  

A.  Highlight the address. 
B.  Select “Open”. (Can also double click on the system) 
C.  Make the appropriate changes. 
D.  Select “Done”. 

 
Step 5:  In the event that YOU HAVE TO CREATE A 
COMPLETELY NEW ADDRESS, first have the Sysad or signal officer 
contact the G-6 for valid address information.   
Select "ALL" from the SYSTEM ADDRESS TYPE and then select "NEW." 
 
 

 
 
 
Step 6:  Enter the following data to complete the system name.  The system 
name is how you will find and recognize that address within your address book. 
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We will use the following example:  RWS 3, G2 OPS, Tactical CP, 4th Infantry 
Division: 

A.  Unit Number – 4 
B.  Unit Organization – INF 
C.  Unit Echelon – Div 
D.  Command Post – TAC                                   Mandatory 
E.  Staff Section - G2 
F.  Staff Element - OPS  
G.  Work Station Qualifier – 03 
H.  Unit Identification Code - optional 

 
Step 8:  Click the "Build System Name" button. Review the information for 
accuracy.  Be sure it is accurate.  Once it is entered into the system, it cannot be 
edited. 
 
Step 9:  Click the "Done" button. 
 
Step 10:  Under "System Type", select the proper system type.  ASAS-RWS-C 
for this system. (RWS Block II).  Other ABCS systems will require other choices. 
Click "Done" 
 
Step 11:  The "Max Accepted Classification" window will appear. Select the 
appropriate classification and click "Validate."  
 
Step 12:  Click "Done" 
 
Step 13:  Highlight the new address name in the “Address Maintenance” window. 
 
Step 14:  Select "Open".  
 
Step 15:  Under "Operating System", select "UNIX". This has no impact on 
transference of messages.  Click done. 
 
Step 16:  Select “New” to enter the Source Enclave Code for the system.  The 
source enclave code is used only in ASAS machines. It is critical for the 
successful sending and receiving of External Database Coordination 
(EDC), a portion of the All Source Correlated Database (ASCDB).  An 
example would be the last 2 characters of your position, iew07w05, or 2 
alphanumeric characters of which the instructor will decide. 
 
Step 17:  Enter the Hostname by clicking "NEW" on the right hand side of the 
"Internet Information HOSTNAME" section.  Enter the IEW # and IP Address 
which is provided for you.  The I.P. Address a series of numbers that identifies 
who you are and where messages are coming from and going to, i.e. 
148.124.121.71.   Check the E-Mail and File Transfer Protocol (FTP) to activate 
them.  Click "Done." 
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Step 18:  The ULP is the Army standard for message headers.  To enter the ULP 
information: 

A.  Click “New” in the header information section. 
B.  Subunit – this fits up to 4 characters.  If you have a sub unit 
designation, which has only 2 characters, such as 11, then add zero’s (0) 
to complete the field, 0011”. (We will not be using the sub-unit in 
RWS CLASS!!!!!!) 
C.  UNIT - This field can fit up to 9 characters.  For example “INF" or 
MECHINF." 
D.  Enter the two-letter COUNTRY CODE in the nation field, such as “US”. 
E.  Enter a NODE DESIGNATION.  This field can fit up to 5 characters. 
“TOC” or “TAC” will most likely be used. 
F.  Enter an ELEMENT. This field can fit up to five characters. “G-2” or “S-
2" will most likely be used. 
G.  Enter a USER. This field requires five characters.  "OPS" or "PLNS" 
will most likely be used. 
I.    The QUALIFIER will always be a number(s).  This usually identifies 
which workstation you are working on. 
H.  Click “Done”. 

 
Step 18:  Click "New" next to the "JANAP PLA". 
 
Step 19:  Enter the JANAP RI and PLA in the appropriate fields. Your SYSAD or 
signal officer provides these.  Note:  TRC is the workstation’s country of origin.  
MSE – phone number needed to contact interface gateway using autodial 
capability if an MSE telephone is used. Gateway is for the destination system 
names.  Click “Done." 
 
Step 20:  At the bottom of the address window is a sub-window that shows the 
methods used to distribute different message types.  It prioritizes it by the type of 
header and the access (delivery) method.  These are prioritized by number with 1 
being the highest priority.  Use the buttons on the side of the sub-window to 
manipulate these priorities. 

A.  In the event that you need to move information using solid media 
(paper, magnetic media), you must move the “Media” option to the first 
priority for the message types you must physically transport.  
B.  To change a priority, highlight the option, and select “Priority Up.” 

 
Step 21:  Click "Done". 
 
Step 22:  To add an address to your Local environment, find the address under 
‘ALL’, highlight it, go to the Selected pull-down menu, and select '‘Add to Local”.   
Step 23:  To delete from Local, select the address to delete, go to Selected, and 
choose “Delete from Local”.  
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Step 24:  In order to edit existing addresses, on the "Resume Maintenance" 
window, select the appropriate address and click "Open."  Make the edits and 
click "Done."  
 
 
Create and Maintain Address Groups  Back to Top 
 
Step 1:  Select the COM FI button. 
 
Step 2:  Double-click "Group Maintenance"   
 
Step 3:   At the top of the menu, select the type of message information which 
will be sent to the group.  ASCII is the default. NOTE:  The type of information 
content determines which systems will appear in the possible destination 
window.  If a system is unable to receive that type of message format, it will not 
appear in the window.  You can also search for systems by using the system 
types and name match search. 
 
Step 4:  Select the addresses you wish to include in the group address and click 
the arrow button to move it to the "Group Members" sub-window. (The arrow will 
highlight when an address is selected) 
Step 5:  Below ‘possible destinations’ is a blank area to enter a unique name for 
your group. Once you have created the group, select Create. 
 
Step 6: There are three default groups in the RWS.  They are the SALUTE, 
THREAT_ALERT and TIDAT_GROUP.  These groups cannot be deleted.  The 
purpose of these groups, once populated with addresses is to enable the system 
to automatically send out these types of messages to consumers.  This will 
become apparent later in the course. 
 
Step 7:  Select “Done”.  This completes the instruction on group addressing for 
message traffic and overlays.  Remember that the group addresses we just 
discussed are not applicable to e-mail. 
 
 
Analyst Mail Operations    Back to Top 
 
Step 1.  Click the button under the “User” queue on the ASAS Banner 
 
Step 2.  Select Analyst Mail 
 
Step 3.  Under Send, select Mail 
Step 4.  Enter the name of the user and system you wish to send e-mail to, such 
as user01@iew01w10 in the name box, or select a previously created recipient, 
alias, or group 
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Step 5.  Select either To or CC (courtesy copy) 
 
Step 6.  Select Add.  
 
*NOTE* You can tag your correspondence with a reply by date/time group; 
Urgent – an explanation mark; Certified – you receive a message when the mail 
is opened; copy to outbox, and add recipients to personal lists.  
 
*NOTE* Aliases are simply nicknames for addresses.  You define these 
nicknames for the system, and after that, you will only have to enter the 
nickname, not the entire e-mail address.  For example, the bravo company 
commander’s e-mail address may be bullrider6@iew99, but you can give him an 
alias of “bravo” which saves time. 
 
Step 7.  To create aliases for your recipients 

A.  Under Lists, select either Personal or Global.  Personal lists are unique 
to the login ID that created the alias, while Global lists are common to all 
logins. 
B.  Select Alias List 
C.  Enter the name of the alias, i.e. DMAIN, in the ALIAS box 
D.  Enter the email address of the alias, i.e. User01@iew01w10 in the 
expansion box 
E.  Select OKNOTE:  The use of a distro list for e-mail is very similar to the 
group addressing we discussed previously.  For example, if you are at 
division and you normally notify each of the brigades by e-mail that you 
have posted a new graphic INTSUM, then you would want to create an e-
mail distr. list for this purpose.  You would include all of the brigades on 
the list, and call it something like ALLBDES.  The name describes the 
members of the list.  Then, every time you post a new graphic INTSUM, 
you can draft a single e-mail, and send it to the distr. list so that everyone 
gets it. 

 
Step 8.  To create a distro list for e-mail: 

A.  Under Lists, select either Personal or Global 
B.  Select Distribution List 
C.  Enter a name for the distro list 
D.  Enter the names of the separate nodes and select Add.  Once you 
have entered all of the names, select OK 

 
Step 9.  Enter a subject 
 
Step 10. Enter the body of your message 
Step 11. To attach a file to your e-mail: 

A.  Click on the button at the top of the window with a picture of the 
paperclip on it 
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B.  Using the Directory button, move through the file directories to the 
desired file. 
C.  Double click on the file 
D.  Select OK 

 
Step 12.  Select “Certified” if you want to know when your recipient has seen the 
mail.  This will give the sender a message once the receiver has opened the 
certified mail. 
 
*NOTE* This effectively sends two e-mail messages for each message sent.  
Excessive use of this option can block up communications pipelines.  
 
Step 13.  Select Copy to Outbox if you wish to keep a copy of the message for 
later review.   
 
Step 14.  To send the message, click OK         
 
 
Review, reply to, forward and delete e-mail  Back to Top 
 
 Step 1.  Click on the User button on the ASAS banner.  A list of all messages in 
your in box will display. 
 
*NOTE* As messages come into the system, the number in the User queue will 
go up.  You will notice this by monitoring the ASAS banner. 
 
Step 2.  Double click on the new message.  The message text will display. 
 
Step 3.  To reply to an e-mail: 

A.  Under Send, select Reply 
B.  Enter a reply message in the Message window 
C.  Click OK 

 
Step 4.  To forward a message to another analyst: 

A.  Under Send, select Forward 
B.  Either select or enter a recipient 
C.  Enter a message in the Message window 
D.  Click OK 

 
Step 5.  To delete a message: 

A.  Click on the message.  It will highlight. 
B.  Under File, select Delete or click on the trash can icon. 
C.  Click Delete at the dialog box.  The message has been moved to the 
Deleted queue.   It can be left there for later review, or completely deleted 
by following these steps. 
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D.  Move to the Deleted queue by double clicking on the waste basket 
folder at the top of the window or from the Options menu select Empty 
Wastebasket. 

 
 
X-File Transfer Protocol (FTP)   Back to Top 
 
Step 1:  On the ASAS Banner, under “Tools” select “User Utilities”. 
 
Step 2:  Select “XFTP”.  When XFTP appears, you can do several functions, to 
include connecting to another machine, transferring, renaming and deleting files 
and directories. 
 
Step 3:  The top of the X-FTP contains 3 pull down menus:  
File, Log and Options – you can change preferences, but they do not change 
once X-FTP is exited.  
On the left hand side of the window will be the hostname with 4 options below it.  
When X-FTP is opened; the directory will always be the “home directory” The bar 
above the home directory contains the following: 

A.  Connect: You can connect to yourself (other side of window), Remote 
(must know hostname, username and password) and Anonymous (no 
longer functions due to security reasons)  
B.  Directory - Go to Previous Directory (contains the last 11 directories 
that the analyst was in), Change and Make directory, Display directory 
path and which side path is on(complete information about files in 
directory), Display directory (Long) – displays table of directory.  
C.  Select or deselect all entries, and Use Wildcard (%) – only searches 
the active directory. 
D.  Ops: You can move, delete and rename items within the system.   

 
Step 4:  To connect to another machine: 

A.  On the right menu, under “Connect” select “Remote”.1.  Remote allows 
you to access the other machines file system.  Your login will be a real 
login, and you will utilize a real password. 
B.  Enter the host name of the machine you wish to connect to.  If you 
have connected to a host before, its name will be displayed.  Double click 
on the name to select it again.   
C.  Enter a user name, if you are connecting to a “Remote” connection. 
D.  Enter the password. 
E.  Select the “Connect” button. 

 
Step 5: To copy a file or directory from one computer to another: 

A.  On your computer,  navigate to the file or directory by double-clicking 
on the directory name in the list to go down, or selecting the directory path 
from the “Dir” pop-up menu to go up the list.  Select the file or directory to 
be copied. 
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B.  Navigate on the right side of the window to the location of the desired 
file or directory by double-clicking on the directory name in the list to go 
down, or selecting the directory path from the “Dir” pop-up menu to go up 
the list. 
C.  Select “Copy” or “Rcopy”. 

1.  Copy - copies only the file highlighted. 
2.  Rcopy - Recursive Copy- copies entire directories.D.  Select 
“OK”.  The copy is complete. 

 
Step 5: To move a file or directory: 

A.  Navigate to the file or directory by double-clicking on the directory 
name in the list to go down, or selecting the directory path from the “Dir” 
pop-up menu to go up the list.  Select the file or directory to be moved. 
B.  Navigate on the right side of the window to desired location of the file 
or directory by double-clicking on the directory name in the list to go down, 
or selecting the directory path from the “Dir” pop-up menu to go up the list. 
C.  Under “Ops”, select “Move Selected Entry (ies)”. 
D.  Select “OK”.  The transfer is complete. 

 
Step 6: To delete a file or directory: 

A.  Navigate to the file or directory by double-clicking on the directory 
name in the list to go down, or selecting the directory path from the “Dir” 
pop-up menu to go up the list. 
B.  Select the file or directory to be deleted. 
C.  Under “Ops”, select “Delete”. 
D.  Select “OK”.  The delete is completed. 

 
Step 6: To rename a file or directory: 

A.  Navigate to the file or directory by double-clicking on the directory 
name in the list to go down the list, or selecting the directory path from the 
“Dir” pop-up menu to go up the list.  Select the file or directory to be 
renamed. 
B.  Under “Ops”, select “Rename”. 
C.  Enter the new name. 
D.  Select “OK”.  The rename is complete. 
E.  Close your connection, and exit XFTP. 

 
*NOTE* Some of the most important directories that you as an analyst must 
know are as follows:/h/users/overlay/Overlays - location of all overlays 
exported/users/overlay/Overlays - location of all overlays 
exported/h/users/INTEL_PRODUCTS - all graphic INTSUM (screen 
capture)/h/users/user01/Office_Products – gif (NT 
side)/h/users/user02/Office_Products – products created by each users will be 
stored in user account.  . 
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Perform Basic Map Operations   Back to Top 
 
Step 1:  Select the “Map Functions” pull down on the ASAS Banner or the Map 
icon on the Common Desktop Environment (CDE).  Select “Map Manager”. 
 
Step 2: There are two options.   
 

Option 1; To open an existing map, click “select named map“ button (and 
continue with step 3,4and 5.)  

 
Step 3:  Select the map window you wish to see. 
 
Step 4:  Select  “OK”. The map window will appear. 
 
Step 5:  Select “Done” on map manager window to complete task. 
 

Option 2; to open a new map window, you must enter the name of your 
new map in the “Selection Window,” then click add.  The new map will 
appear.  Select “Done” on map manager window to complete task 

 
 
Creating and saving  
map preferences.      Back to Top 
 
Step 1:  On the map window, along the bottom you will see the buttons for the 
type of map, the map scale, the zoom factor, and the coordinate scale used.  On 
the left side are the controls for drawing, the contrast of the map, and the step 
size for panning across the map.  Along the top the TEM Map is displayed the 
current location of the cursor on the map and the Datum being used by the 
system.  The following is a list of the different TEM Map controls and a brief 
description of each. 
 

A. Arrow Keys – Pans the map around. 
 

B. Home Key – Shaped like four inward pointing arrows.  Causes the map  
to re-center on the “Home” location (as stored in preferences). 

 
C. Pan Step % - Sets the percentage (of the whole screen) that the map 
will move (Pan) when the arrow keys are used. 

 
D. Jump To – Allow you to enter a grid location (MRGS, LAT/LON, or 
UTM) or a place name (that exists in the system gazetteer) and then press 
the Jump To button to center the map on the location. 
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E. Contrast – Changes the contrast of the map +/- (0 = Black and 100 = 
White).  This allows you to view symbology and other map items easier on 
certain map backgrounds. 

 
F. Redraw – Refreshes the screen.  Used mostly when TEM doesn’t clear 
the screen automatically. 

 
G. Orange Menu Button – Contains options that affect the map directly. 

 
H. Focus – Tells the computer what map (if multiple are open) to use for 
plotting operations. 

 
I. Show AOI - Displays a selected AOI on the map in easy to read colors 
and fonts. 

 
J. Legend – Turns on/off the map legend used with the terrain evaluation 
features of TEM. 

 
K. Tool Palette – Toggles on/off 

 
L. Pref Ops – Toggles on/off 

 
M. Redraw – Same as redraw above. 

 
N. Close (Destroy) – Closes the map. 

 
Step 2:  To change the type of map you are using, click and hold on the “Map” 
button.  Move the cursor to the map type you wish to use and release the mouse 
button.  Your choices are: 

A. Blank – No data displayed (Black Background) 
B. E-Map -  Military Maps. A compression of ADRG data.  ADRG is the 
digital equivalent of a paper map.  CD-ROMs are available from 
DMA/NIMA. 
C. DADRG - Modified Military Map (Derived Arc Digitized Raster 
Graphics) 
D. Relief – Shows the relief features of the area in a gray-scale 
environment.  Generated from DTED Data. 

 
Step 3:  To change the scale of the map: 

A. Click on the “Scale” button. 
B. Select the scale you wish to use. 

 
Step 4:  To change the zoom factor of your view: 

A. Click on the “Zoom”  button. 
B. Select the zoom factor you want to use.  The different values are ratios.  
For example:  1/4 is the factor for zooming out so that the map is 4 times 
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as big as normal, allowing you to see more area, but with less detail.  If 
you choose 4, you will zoom into a very small area of the map, but with 
greater detail. 

 
Step 5: On the preferences bar next to Zoom is a toggle button for grayscale.  
When toggled, the map displays in shades of gray.  (This is useful when viewing 
plotted information, which may not show up well against a color map). 
 
Step 6: To change the coordinate system you will be using: 

A. Click on the “Coordinate” button. 
B. Select the coordinate system you will be using.  We will normally be 
using MGRS. 

 
Step 7:  To change the datum you: 

A.  Select the “preferences” button on the TEM banner. 
B.  Select the datum you will be using, and select "OK”.  WGS 1984 is the 
standard, but others are used frequently. 

 
Step 8:  To change your Home (Center) location in preferences: 

A. Click on “Home/AOI” button. 
B. Enter a center location in the “Home Location” text box by typing it in 
manually, or; 
C. Choose the “Map Pick” button to choose a location directly from the 
map, or; 
D. Select an AOI from the AOI List at the bottom of the window and the 
press the “AOI Center” button. 
E. Select “OK” to save your changes. 

 
Step 9:  To save this map window with these preferences: 

A. Click on the “Save” button in the lower right hand corner.  A 
preferences dialog box displays. 
B. Enter a name for this group of preferences.  This name will be 
displayed when choosing the “Select Named Map” option in the Map 
Manager. 
C. Designate whether or not you wish this to be the default settings for all 
maps. 
D.   Select “OK”.  The map window is now saved and can be retrieved 
through the “Map Manager”. 
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Toggle grids by KM (kilometers) Using the TEM Window  Back to Top 
 
 

 
 
 
Step 1: From the TEM Menu Bar, select View. (The view options display in a pull-
down menu).  
Step 2: Select Toggle UTM Grids or Toggle KM Grids from the pull down. (The 
map grids display in white on the map background in the current selected datum 
or KM reference). 
 
Step 3: To turn off the grids, select the appropriate toggle again. When Toggle 
KM Grids is selected, changes in grid square size is executed by picking 1, 5 or 
10 KM grids. 
 
 
Determining Available Map Coverage (TEM).   Back to Top 
 
Step 1:  Position your map window on the area for which you are looking for map 
data. 
 
Step 2:  Under “View” in the TEM menu, select “Inset Map”. 
 
Step 3:  Select “Jump” in the Inset Map Window.  The inset map will jump to the 
area your main map window shows.  The green rectangle displays in the inset 
map. 
 
Step 4:  Select the window next to the white down arrow.  The menu of available 
map data types will come down.   
 
Step 5:  Select the type of map data coverage you wish to see.  If the map data is 
available, then a red crosshatch will appear over the area for which it is available. 
 
 
Create and plot Geographical Areas.    Back to Top 
 
Step 1: Select "Geographical Areas" from the "Map Functions" menu. 
 
Step 2: Select the type of area you wish to create. NAI, TAI, DP and AOI are 
provided. 
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Step 3:  Under "File", select "New". 
 
Step 4: Enter the appropriate information.  The vertical bar in front of the fields 
indicates the mandatory fields.  The mandatory fields are name and location. 
 
Step 5:  Enter the location manually or using the "Map Pick" button.  The "Map 
Pick" button allows the user to click on the map and insert the grids into the 
window.  

1.  For a rectangle, either manually enter the lower left and upper right or 
use "Map Pick". 
2.  For a circle, either enter the center coordinate manually or use "Map 
Pick'> Then enter the radius in KM. 
3.  For a multi-sided area, the following steps must occur: 

A. "Map Pick", select the points on the map which will make up  the 
corners of the area. 
B. Red "plus" signs will appear when you click on the map with the 
LMB. 

 
Step 6: After all locations have been selected click on the RMB.   
 
Step 7: Select "Insert". 
 
Step 8: Select "Plot Area".  (the Geographical area will display) 
 
Step 9: Select the "Save" button. 
 
 
Editing an Existing Geographical Areas:  Back to Top 

 
Step 1:  Select the area to be modified (click the LMB to highlight it) 
 
Step 2: Select "Open". 
 
Step 3: Make the appropriate modifications. 
 
Step 4: Select "Done". 
 
 
Creating an AOI:      Back to Top 

 
Step 1:  Under Map Functions, along the system top banner, select 
"Geographical Areas."  The Geographical Areas window appears. 
 
Step 2:  Select "AOI" for the type of area you will be creating, then under file 
select "new AOI." 



 26

 
Step 3:  Enter a name for the AOI in the “Name” field. 
 
Step 4:  In the location box choose the style of area desired.  Rectangular, 
Circular or Multiple. 
 
Step 5: Select save and, done. A new AOI is created. 
 
Step 6:  To view the new AOI, select the “Map Name” pull down menu.  
 
Step 7:  Select “ Show AOI”. 
 
Step 8:  Select desired AOI by name, select OK, AOI will plot on map as a 
labeled orange and yellow lined box. 
 
 
Deleting an AOI      Back to Top 

 
Step 1:  On the TEM Banner, select the “File” button.  A menu will appear.   
 
Step 2:  Select “Delete”. 
 
Step 3:  Select Areas of Interest.  The delete AOI window appears. 
 
Step 4:  Highlight the title you want to delete. 
 
Step 5:  Select OK or Apply. 
 
 
Converting coordinates from one  
datum/coordinate system to another.    Back to Top 
 
Step 1:  Under “View”, select “Coord Calc”. 
 
Step 2:  Under “Input”, select “Coordinate Type”. 
 
Step 3:  Select the coordinate system you will be converting from. 
 
Step 4:  Under “Input”, select “Datum”. 
 
Step 5:  Select the datum from which the original coordinates were calculated. 
 
Step 6:  Under “Output”, select “Coordinate Type”. 
 
Step 7:  Select the coordinate system you will be converting to. 
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Step 8:  Select Coordinate format.  Choose UTM, MGRS or GEO. 
 
Step 9:  Under “Output”, select “Datum”. 
 
Step 10:  Select the datum the converted coordinates will be calculated from.   
This will normally be the datum you are using on your map window. 
 
Step 11:  Enter the coordinate you want converted in the “Input Coordinate” field. 
 
Step 12:  Select the “Convert” button.  The converted coordinate will be displayed 
in the “Output Coordinate” field. 
 
 
Generating terrain categorization  
overlays based on loaded map data   Back to Top 
 
Step 1:  From the TEM menu bar select Evaluate.  A pull down menu of all 
evaluation types displays. 
 
Step 2.  Select Terrain Categorization.  The Select overlay type window displays. 
 
Step 3.  Select the desired overlay type.  Commonly used choices include 
Elevation bands, Obstacles and Drainage.  DTED is specific to elevation 
overlays.  If the name includes DFAD, that type of data must be loaded.   
 
Step 4.  Select OK.  A “Create Overlay” window displays for the overlay type you 
selected. 
 
Step 5.  Select the TEM Area of Interest (AOI) where this overlay should be 
generated.  Use the scroll arrows to select the AOI.   
 
Step 6.  Pick OK or Apply in the Create Overlay window.  TEM will produce the 
new overlay and display an information dialog box indicating the new overlay was 
created.   
 
Step 7.  Pick OK in the TEM information window.  You may now view the TEM 
overlays by using Overlay controls under the View pull down in TEM. 
 
 
Viewing and deleting TEM overlays    Back to Top 
 
Step 1.  From the TEM menu bar, select View.  The Overlay controls window 
displays. 
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Step 2.  Select “Add Overlay”.  This brings up the “Select Overlay(s) window.  
The Overlay Controls window is used to manage currently displayed overlays, 
and to load new ones from the Select Overlay(s) window. 
 
Step 3.  From the Select Overlay(s) window, select the AOI you are interested in.  
Then select the overlay group (VIS, TER or MOB).  This opens the list of 
overlays.  
 
Step 4.  Double click on the overlay name.  It moves to the Overlay Control 
window. 
 
Step 5.  Highlight the overlay and select Redraw.  The overlay is displayed.   
 
Step 6.  To turn on the Legend, select the legend toggle under the Map Name 
button on the map.  The legend is useful in that it shows if a given type of map 
data is available.  You can also toggle boxes next to features to turn off or on the 
features.  Use redraw to view the changes. 
 
 
Deleting TEM Overlays:     Back to Top 
 
Step 1.  From the TEM menu bar, select File.  A pull down displays the File 
options. 
 
Step 2.  From the File pull down menu, select Delete.  A listing of the types of 
things that can be deleted displays. 
 
Step 3.  Click on Overlays.  A delete Overlays window displays.  it has a list of 
overlays organized by AOI and Overlay type, (IE: VIS, TER, or MOB).  Select the 
overlay(s) you want to delete.  
 
Step 4.  Select OK or Apply.  Once an overlay is deleted, it cannot be recovered.  
A new overlay would need to be built. 
 
 
Conducting LOS Calculations:    Back to Top 
 
Step 1.  From the TEM menu bar, select evaluate.  All forms of TEM evaluations 
displays. 
 
Step 2.  Select Observer LOS, Observer LOS options are displayed by using the 
right arrow pull down.  These options are Point Target and Masked Area Plot. 
 
Step 3.  Select Point Target.  The Point to Point Profile window displays.  The 
display area of the window shows the resulting terrain profile and LOS prediction.  
There are also fields for selecting Start and End Points, Start and End heights 
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and toggles if you want to use meters or feet.  You also choose Optical or 
electromagnetic LOS. 
 
Step 4.  Enter a Start point, This is the position of the Observer.  This can be 
done manually or from the map.  Select the start button and pick a map location 
with the LMB. 
 
Step 5.  Enter an End Point.  This is the target.   
 
Step 6.  Enter the start and end heights.  Type numeric values in these fields to 
indicate “Height Above the Ground” for the Observer and the Target.  Toggling to 
the right of these fields allows you to select the unit of measure, either feet or 
meters. 
 
Step 7.  Select either Optical LOS or Electromagnetic LOS.  Electromagnetic 
LOS (radio) uses a different algorithm. 
 
Step 8.  Select Apply.  The terrain displays with a line between the two selected 
points.  A solid green line indicates there is probably good LOS.  A dashed red 
line means no LOS is possible.  If you get a red line you will probably see where 
the line intersects with the terrain profile. 
 
 
Creating LOS Overlays:     Back to Top 

 
Step 1.  From the TEM menu bar, select Evaluate.  A pull down with available 
options displays. 
 
Step 2.  Select Observer LOS.  The LOS choices are selected by clicking on the 
arrow to the right. 
 
Step 3.  Select Masked Area Plot.  The Masked Area Plot Analysis window 
appears. 
 
Step 4.  Select the AOI for this analysis.  The desired AOI name is displayed 
using the up and down arrows for scrolling. 
 
Step 5.  Type a Name for this overlay.  A value must be entered in the name field 
to successfully create this overlay. 
 
Step 6.  Select the Optical Sensor Type.  Choose either unaided vision or x5 
Binocular.   
 
Step 7.  Select the Target Type.  A list of targets is provided, and includes 
Soldiers, Tank, Helicopter and Missile launcher.  Sensor Type and Target Type 
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are considered to determine the range value of the plot.  This value can be 
changed also. 
 
Step 8.  Select a source location.  This can be entered manually or from the map.  
This is the observers’ location. 
Step 9.  Set the Bounding Azimuths.  Enter left and right azimuths if you need to 
be more specific than the default of 0-360.  An example would be to determine 
the Avenue of Approach. 
 
Step 10.  Set Source and Target height.  The source defaults to 1.8 meters (a 
standing person) and target defaults to 0.  These values can be adjusted to fit the 
situation. 
 
Step 11.  Select the Analysis Type.  This determines the number of overlays 
created (1 or 2). The choices are “Visibility and How High Target” and “Visibility 
Probability”.     
 
Step 12.  Enter the Weather data,  Month and Time of Day.  click on the buttons 
to bring up list of options. 
 
Step 13.  Select Apply or OK.  The TEM Visibility overlays can be loaded by 
using View and Overlay Controls. (See learning step/ activity 6)  The Map 
Legend is used to interpret the results. 
 
 
Speed and reason Mobility overlays:    Back to Top 
 
Step 1:  From the TEM menu bar, select evaluate.  The list of evaluation types 
displays. 
 
Step 2:  Select Speed and Reason Mobility.  The Ground Mobility Analysis 
window displays. 
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Step 3:  Select your AOI.  An AOI must already have been created using 
"File/New/AOI" under the TEM menu bar.  The arrows are used to display the 
name of the desired AOI.   
 
Step 4:  Type a name for this overlay. 
 
Step 5:  Select the Unit/Vehicle type from the list.  This defines the model that will 
be applied to the terrain. 
 
Step 6:  Select the Movement Plans for the entity.  Multiple selections are 
permitted.  Cross-country is the most frequent choice.   
 
Step 7:  Select the Month of the expected movement.  This is an optional field.   
 
Step 8:  Modify Additional required information.  Certain variables can effect 
speed and mobility.  You can modify the following fields: driver visibility, surface 
soil condition, river water level, and thirty-day precipitation. 
Step 9:  Select OK or Apply.  Three dialogs display in succession indicating the 
Mobility Analysis started, and the successful creation of a "Mobility Reason" and 
a "Mobility" overlay.  Remove the dialog boxes by clicking OK.  View the overlays 
through View/Overlay Controls. 
 
 
Path Distance and Azimuth and Distance tool:   Back to Top 
 
Step 1:  From the TEM menu bar, select evaluate.  The list of evaluation types 
displays. 
 
Step 2:  Select Path Distance, Click on the arrow to the right.  This gives you the 
option of selecting “By Ground” or “As the crow flies”.  The two options are 
virtually identical in function.  The only noticeable difference is the color of the 
plot. 
 
Step 3: Select By Ground.  The map appears to clear.  Follow directions on the 
top portion of the TEM menu bar. 
 
Step 4:  Select points on the map with the LMB,  multiple points are used to trace 
routes etc.   
 
Step 5:  Click the RMB when you are done entering points.  This brings up a 
TEM information window that gives you a textual display of the results.  This 
shows the coordinates of points entered, azimuth between the points and 
distance between the points in miles and kilometers.  The information is also 
plotted on the map with a red triangle marking the points, arrows along the path 
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and markers showing distance between the points.  To remove the distance 
plots, select with the LMB, click and hold the RMB, and move down to “Remove”. 
 
Step 6:  Click on the CMB to cancel or turn off the distance tool.  The TEM 
function is looking to do additional plots if you don’t turn off the function. 
 
Step 7:  To use the Azimuth & Distance tool click on “Azimuth & Distance.  
Follow the directions at the top of the TEM menu. 
Press and drag with the LMB on a point on the map.  Your start point is where 
you initially touched the map.  As you drag the cursor to different positions, The 
TEM menu will display the azimuth in degrees, and distance in miles and 
kilometers from your initial point.  
 
 
Conducting Mobility Corridor Analysis:    Back to Top 
 
Step 1:  Select “Evaluate” from the TEM menu. 
Step 2:  Select “Mobility Corridors” from the pull down. Click on the arrow to the 
right of Mobility Corridors.  Select Ground.  This brings up the “Ground Mobility 
Corridor Analysis” window. 
 
Step 3.  Select one of the previously created Speed and Reason Mobility 
evaluations you created.  
 
Step 4:  Select OK or Apply.  You will get three notification windows indicating 
the processing of the analysis.  When the analysis is complete.  The overlay can 
be viewed using the Overlay Control tool. 
 
 
Free Draw Graphics:      Back to Top 
 
Step 1: Open your default map. The Free Draw controls are on the left side of the 
map.  You can use these control buttons to draw circles, polygons, ellipse, lines, 
rectangles, add text labels to the map, add military symbols, and plot markers for  
reference locations.  The Mouse functions for all free draw objects are displayed  
at the top of the TEM Menu window. 
 
Circles Tool:      Back to Top 

 
Step 1: Select “Draw Circle” from the Free Draw control panel.  The TEM menu 
bar indicates “Draw Circle” is selected. The draw object tool is activated. Move 
the cursor over the map window.  
 
Step 2: Move the cursor to the location on the map which will be the center of the 
circle. 
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Step 3: Click and hold the LMB. 
 
Step 4: Drag the cursor across the map to the point, which defines the radius of 
the circle. 
 
Step 5: Release the LMB. 
 
Step 6: Click the CMB to turn off the circle tool. 
 
 
Ellipse Tool:       Back to Top 

 
Step 1: Select the “Draw Ellipse” icon. 
 
Step 2: Move the cursor to the location which will be the center of the ellipse. 
 
Step 3: Click and hold the LMB. 
Step 4: Drag the cursor across the map in the direction you want the ellipse 
oriented to a point that defines the major axis of the ellipse. 
 
Step 5: Release the LMB.  The ellipse will display on the map.  The major axis 
and orientation will correspond to how you drew them on the map.  The minor 
axis is a default ratio of major axis.  To change this, edit the drawn graphic. 
 
Step 6: Click the CMB to turn off the ellipse tool. 
 
 
Line Tool:       Back to Top 

 
Step 1: Select the “Draw Line” icon. 
 
Step 2: Move the cursor to the starting point of the line.  Click the LMB. 
 
Step 3: Move the cursor to the next point and click the LMB.  Repeat this step as 
necessary. 
 
Step 4: When you have established the last point on your line, click the RMB to 
end the line.  The line will display. 
 
Step 5: Click the CMB to end the line tool. 
 
 
Rectangle Tool:      Back to Top 

 
Step 1: Select the “Draw Rectangle” icon. 
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Step 2: Move the cursor to the location of a corner of the rectangle. 
 
Step 3: Click and hold the LMB. 
 
Step 4: Drag the cursor to the opposite corner of the rectangle. 
 
Step 5: Release the LMB.  The rectangle will display. 
 
Step 6: Click the CMB to turn off the rectangle tool. 

 
 
Polygon Tool:      Back to Top 

 
Step 1: Select the “Draw Polygon” icon. 
 
Step 2: Move the cursor to the starting point of the polygon.  Click the LMB. 
 
Step 3: Pick the points for the polygon by clicking on the LMB. 
 
Step 4: Press the RMB to complete the polygon.  This action will connect the last 
point with the first, closing the shape. 
 
Step 5: Click the CMB to turn off the polygon tool. 
 
 
Text Tool:        Back to Top 
 
This tool allows you to add standalone text in the map window or add labels to 
objects. The steps below are for adding text to the map window. To add text to a 
Draw Object symbol, select the symbol from the map, then begin these steps. 

 
Step 1: Select the “T” icon.  The free text form will display.  Free text on the map 
can be manipulated to three different sizes.  Text on a symbol is limited to one 
size.  Symbol color can be set using Fill Color on the Draw Palette 
 
Step 2: Enter the location in the location field.  It can be entered manually or by 
clicking on the location on the map using the LMB. 
 
Step 3: Enter the text to be displayed in the “Text” field. 
 
Step 4: Select the “Done” button.  If added to a symbol, the text plots center of 
mass on the symbol, otherwise the location entered is the anchor point. 
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Military Symbols:       Back to Top 
 
You can free draw military symbols on the map.  However, this information does 
not save to the database.  If you wish to pass this information along to another 
RWS, you should make an entry into the database by highlighting them and right 
clicking on the map and pressing “DB Update.”  The symbols also cannot be 
included in the S309, Enemy Interoperability message.   
 
Step 1: Select the military symbol icon.  The “Symbols Category” form will 
display. 
 
Step 2: Select the type of symbol you wish to create and select “OK.”  Available 
categories are: Units/Headquarters; Installations; Equipment; Ground Control 
Points; Ground Control Lines; Ground Control Areas; Ground Control Routes; 
Ground Control Movements; Ground Control Boundaries; Air Control Points; Air 
Control Lines; Air Space Control Areas; Crossings; Mines/Obstacles - Demolition 
Status; Mines/Obstacles - Point; and Mine/Obstacles - Linear. Each selection 
presents a form with interactive lists and fields to be completed.  
 
 
Creating Unit Symbols:     Back to Top 

 
Step 1: Select “Units/Headquarters” in the “Symbols Category” form. 
 

 
Step 2: Using the menu, manipulate the unit symbol traits of Unit shell, Branch 
type, Organization type, and Echelon. Color can be selected, Allegiance is the 
default, and Friendly or Enemy can be toggled.   
 
Step 3: Enter information into the mandatory fields.   The mandatory fields are 
Unit number, Location and Allegiance.  Location can be either manually entered 
or designated from the map.  Allegiance uses the DIA country codes. 
Step 4: Select “OK” or “Apply”.   
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Adding Free Draw Entities to the ASCDB:    Back to Top 
 
Step 1: Left click on the unit to highlight it.   
 
Step 2: Right click to open the “Entity Operations” window.   It will be displayed 
with a “draw” listed under the entity context.  This means it is not in the database 
(if it were a DB file then CDR would be displayed).   
 
Step 3: Select the “Database” pull down menu.  DB update/insert puts the record 
into the DB as a CDR.  Edit and Update allows you to put additional information 
in the record such as parent unit information.  The entity is then parsed into the 
DB. 
 
 
Creating other Military Control  
Measures in Free Draw:     Back to Top 
 
You can use Free Draw to place Phase Lines, Boundaries, etc. directly on the 
map.  However, you must remember that these objects are not placed in 
Battlefield Geometry and can't be sent out on an S309 (Enemy Interoperability 
Message).  Additionally, there are not provisions to add these control measures 
into the database like unit symbols can be added into the ASCDB. 
 
Step 1: Select the military symbol icon. 
 
Step 2: Select the type of symbol you wish to create, then select “OK”. 
 
Step 3: Fill in location.  This is the only mandatory field. 
 
Step 4: Set any other parameters that you want. 
 
Step 5: Select “Apply”. 
 
 
Quick Plot/Map Notes:       Back to Top 

 
Step 1: Select “QP” from the Free Draw controls. 
 
Step 2: Enter the location.  Can be entered manually or click on “From Map” to 
enter the points from the map.” 
 
Step 3: Enter text into the label field.  This field is not mandatory. 
 
Step 4: Under “Operations”, select “Center Map” to view the plot. 
 
Step 5: Click the  “Plot” button.  The symbol will plot on the map. 
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Step 6: Select “Done” to exit. 
 
 
Editing Free Draw Objects:     Back to Top 
 
These steps will not work on entities plotted from the database. Those entities 
must be manipulated using entity operations. 

 
Step 1:  Click on the object to highlight it.   
 
Step 2:  Click and drag on the object to move it. 
 
Step 3:  Military symbols and text will display their original forms for editing.  
Make your changes and select “Done”. 
 
Step 4:  To delete an object, highlight it and click on the “Delete” button on the 
toolbar.   
 
 
Utilizing the OB (Smart) palette:    Back to Top 
 
Step 1:  Open your default map. 
 
Step 2:  To access the OB/Smart palette, go to the left hand side of the map 
window, under “Palette”, and select “GSD Symbol” 
 
Step 3:  Create a symbol using Free Draw.  For the purpose of this 
demonstration create an armored recon platoon. 
 
Step 4:  Select “Add to Palette”.  The symbol will be included in the palette. 
 
Step 5:  To add a symbol already on the map, highlight the symbol. 
 
Step 6:  Select “Pal <-- Map”.  The symbol will be included in the palette. 
 
 
Plotting Symbols from the  
OB/Smart Palette:       Back to Top 
  
Step 1:  Select the desired symbol on the palette to highlight it. 
 
Step 2:  Move the cursor to the desired location on the map.  
 
Step 3:  Click the LMB.  The symbol will display on the map.  Every time you click 
the LMB, a copy of the symbol will appear. 
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Step 4:  Click the center mouse button (CMB) to exit. 
 
 
Saving Groups of Symbols to Different Palettes  Back to Top 
 
You can save groups of symbols to different palettes to organize them.  This is 
useful to break up symbols between artillery, motorized rifle, tank, etc. 
 
Step 1:  Add desired symbols to palette. 
 
Step 2:  Select “Show Palette Manager”. 
 
Step 3:  Enter a name for the palette. 
 
Step 4:  Select “Save”. 
 
Step 5:  Before you build a new palette, you must select “Clear” to remove the 
icons to start with a fresh palette. 
 
 
Loading Saved Palettes:     Back to Top 
 
Step 1:  In the “Palette Manager”, highlight the name of the palette. 
 
Step 2:  Select “Load.”  The group will be displayed in the palette after all 
previously loaded symbols. 
 
Step 3:  Select “Hide Palette Manager” to close the “Palette Manager” window. 
 
 
Generate control measures using  
Battlefield Geometry:     Back to Top 
 
Step 1:  Under the Map Functions on the Tool bar or the CDE, Select “Battlefield 
Geometry”.  
 
Step 2:  Select “New”, or under the File pull down, select New.  
 
Step 3:  The Symbol category window displays.  
 
Step 4:  Select a category of battlefield geometry and click “OK”. 
 
Step 5:  Enter the necessary information.   
 
Step 6:  Select “Locations". 
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Step 7:  Select them on the map with the LMB.  Click the RMB to end selection.   
The line will be displayed in blue. 
 
Step 8:  Select “OK”.  The control measure will be drawn on the map.   
 
Step 9:  Select  “Save” on the Sit-Battlefield geometry window. 
 
Step 10:  Enter a name and select “OK”. 
 
Step 11:  Enter a comment if required and select “OK”.  The control measure will 
be saved and will display in the control measures window. 
 
 
Creating a group of control measures:   Back to Top 
 
Step 1:  From the Battlefield Geometry window, select the Control Measures tobe  
grouped (click and drag over selected measures highlighting). 
 
Step 2:  From the Selected menu, choose Group. (A dialog box will display 
prompting the user for a group name). 
Step 3: Enter a name and click OK. (A dialog will display prompting the user for 
comments.) 
 
Step 4:  Enter a comment if desired and click OK. (The control measure group 
will be saved and will display in the appropriate area of the Battlefield Geometry 
window. The type will display as "Group"). 
 
Step 5:  To add Control Measure to a Group; the following steps must be applied: 

A. From the Battlefield Geometry window, select the group.  (The group is 
highlighted) 
B. select the Control Measure to add. (highlight using the LMB and the 
CTRL key) 

 
Step 6:  From the Selected menu, select Append. (The control measure will be 
added to the group). 
 
 
Reviewing Control Measures:     Back to Top 
 
Step 1:  From the File menu, select Refresh. (This ensures you have the latest 
entries available for review). 
 
Step 2:  Select a Control Measure to review. (All incoming control measures will 
be identified as "NEW". Once they are plotted they will be identified as "ORG").  
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Step 3:  From the Selected menu select Plot or choose the Plot button. (The 
control measure is displayed on the map for review. The Plot and Center 
selection may also be used. This centers the map on the plotted control 
measure.) 
 
Step 4:  From the Selected menu select Edit or choose the Edit button. (The 
information box for the selected Control Measure will be displayed for review or 
editing. The Edit and Center selection may also be used. This centers the map 
on the control measure to be edited. Should you choose to edit the control 
measure, the edited control measure will display in the Battlefield Geometry 
window as "EDT" (edited).  The original control measure will still display in the 
window. Should you have no need for the original control measure, you may 
delete it.  
 
Step 5:  Select Save from the Battlefield Geometry window if you have edited the 
control measure. 
 
 
Sending an S201 Battlefield Geometry message:  Back to Top 
 
Step 1:  Select a Control Measure or Control Measure group to send. (You may 
select only one control measure to send in the S201. If you have multiple control 
measures you wish to send, create a group containing these control measures 
and select the group as the control measure to send). 
 
Step 2:  From the Selected menu, select Send S201. (The Send S201 Message 
window displays). 
 
Step 3:  Complete the S201 header. The mandatory fields are: 

A. The options for action upon arrival at the destination.  Your choices are 
"Add" or "Amend". 
B. The operations order or plan number. The Date Time Groups. (The 
time groups must be sequential.) 
C. Either "Automatic" or "AutoFill/Review".  Automatic will automatically 
create and transmit the message without user review.  AutoFill/Review will 
create the message, but the analyst will have to manually review the 
message and transmit it. (The error dialog at the bottom will indicate when 
incorrect or incomplete data has been entered). 

 
Step 4:  Select Done (The COM-Destination Addressing Battlefield Geometry 
window displays). 
 
Step 5:  Complete the COM-Destination Addressing Content-Battlefield 
Geometry window. (You must choose a destination from the COM-Destination 
Addressing window. Ensure the destination you choose is able to receive the 
S201. The type of messages destination can receive is part of the resume.  
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Step 6:  Select Done (If AutoFill/Review was selected, the message must be 
reviewed by selecting the SIT outbound queue to review and manually release 
the message. If Automatic was selected, the message will be sent and a dialog 
box will display with the status of the message). 
 
 
Country Code:       Back to Top 
 
Step 1:  From the DBM FI top-level menu, select “Table Maintenance Tools”.  
The Table Maintenance Tools menu opens. 
 
Step 2:  From the Table Maintenance Tools menu, select “Country Code 
Maintenance”.  The Country Code Maintenance window opens. 
 
Step 3:  Click on a search field and find your criteria on the pull down menu.  You 
may select more than one criteria. If more than one of the ECC, DIA, TPD, or 
Geographic Name fields are used, the logic operator between the fields is "OR".  
This means that if you enter values in different fields, the system will search for 
"this or that or that".  In this way, you can search for a criterion that matches a 
country code at the same time as a geographic name or an icon color, etc.  The 
system will return all entries that match any of your criteria.  The Align, Color, DIA 
Type, and Class fields employ "AND" logic.  This means that a value must match 
all parameters to be returned. 
 

A. DIA field:  Clicking on this field activates a pull-down menu that allows 
you to search for a specific Defense Intelligence Agency (DIA) code. 
B. TPD field:  Clicking on this field activates a pull-down menu that allows 
you to search for a specific Target Product Designator (TPD) code. 
C. Geographic Name field:  This is a field where you may enter a country 
name. If you do not know the complete name or the correct spelling, you 
may use a wild card (%) with a fragment of the name. 
D. Align field:  Clicking on this field activates a pull-down menu that allows 
you to search for entries that match an alignment of Friendly, Hostile, 
Neutral, or Pending. 
E. Color field:  Clicking on this field activates a pull-down menu that allows 
you to search for entries that match the color selected. 

           F. DIA Type field:  Not used at this time. 
G. Class field:  Clicking on this field activates a pull-down menu that 
allows you to search for entries that are of a certain classification.  Entries 
that are at or below the classification of your machine will be the only ones 
available to you. 
H. Search button:  Activates the search based on entries you have 
selected using previously described fields. 
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I. Sort By button:  Activates a pull-down menu to select criteria you would 
like to sort by. You may select any of the criteria previously listed in this 
section. 
J. Clear button:  Clears all fields of any entries you have selected.  This is 
especially useful if you have made a number of selections and want to 
create a new search without being confused by other entries. 

 
Step 4:  Click on the “Sort” By button and select search criteria from the pull-
down menu.  The default is sort by Geographic Name. 
 
Step 5:  From the file menu, select “Search” or click the “Search” button.  The 
results of your search are displayed in the Search Results panel sorted by the 
criteria you selected. 
 
 
Adding a New Country Code     Back to Top 
 
Step 1:  From the DBM FI top-level menu, select “Table Maintenance Tools”.  The Table 
Maintenance Tools menu opens. 
 
Step 2:  From the Table Maintenance Tools menu, select “Country Code Maintenance”.  
The Country Code Maintenance window opens. 
 
Step 3:  Make entries in the appropriate fields in the Add/Modify section.  A vertical bar 
on the left of the field denotes mandatory fields.  Some fields will activate a pull down 
menu when you click in the field. Only values on the menu will be accepted by the 
system.  Each entry for the ECC, DIA, TPD, and Geographic Name must be a unique 
entry. If it is the same as any other entry in the database for that field, you will receive an 
error message that the line will not be saved. 
 
Step 4:  Select “Apply Record” from the File menu or click the “Apply” button.  This 
commits the line to the database and validates the entries. The system will highlight fields 
with errors.  The errors must be fixed before it will apply. 
 
Step 5:  Select “Activate” from the file menu to distribute changes. 
Task 
 
 
Modify an Existing Country Code   Back to Top 
 
Step 1:  From the DBM FI top-level menu, select “Table Maintenance Tools”.  
The Table Maintenance Tools menu opens. 
 
Step 2:  From the Table Maintenance Tools menu, select “Country Code 
Maintenance”.  The Country Code Maintenance window opens. 
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Step 3:  Using the search function, display the entry to be modified in the Search 
Results panel. 
 
Step 4:  Click on the entry to be modified.  The entry highlights in the Search 
Results panel. 
 
Step 5:  Select “Open” from the Selected menu or click the “Open” button.  The 
record selected in the Search Results section is opened and placed in the 
Add/Modify section. 
 
Step 6:  Make changes to the entry in the Add/Modify panel. 
 
Step 7:  Select “Apply Record” from the File menu or click the “Apply” button.  
The changes are displayed in the Search Results panel. 
 
Step 8:  Select “Activate” from the file menu or click the “Activate” button to 
distribute changes. 
 
 
Conduct Entity Hierarchy Maintenance:  Back to Top 
 
 
Step 1: Either click DBM FI identifier in banner or double click the DBM FI 
identifier in the CDE.  
 
Step 2: Double click the Table Maintenance Tools option.  
 
Step 3: Double click Entity Hierarchy Maintenance option.  
 
Step 4: Click desired Entity Type entry. Either Unit, Equipment, Facility, Radio, or 
Radar  
 
Step 5: Click desired Search String Type entry.  
 
Step 6: Type in desired Search String (% can be used before and after).  If you 
are going to build an new piece of equipment, you should first check to see if the 
equipment already exists in the database.  Example- To search for the 
equipment name "T-72" type %72% or %T-7%, etc.. Each will return any record 
with the  "T-7 or the "72" in the record.  
 
Step 7: Click Query button.  If your search for the piece of equipment returns 
nothing, you can safely assume that it is not in the database and has to be built. 
 
Step 8: Click Show Hierarchy button.  
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Step 9: Select the appropriate category for the equipment you are creating, i.e. 
TANK, MDM, and NFI.  Do this by clicking on the '+' sign or equipment type that 
best matches the type of equipment you will be adding to the database.  
 
Step10: Select Create option under Selected pull down menu.  The create 
equipment window will display.  
 
Step11: Fill in form (name, max range and min ranges, entity code, classification, 
and select the appropriate equipment symbol).  Special Note: Equipment names 
and Entity codes are controlled by Defense Intelligence Agency and can be 
found in the DIA Equipment List provided in its national level database.  This 
information may also be found in the ASAS All Source System, which is located 
at Corps and Div. If you are unable the get a good entity code, you can fake one 
in by choosing a similar entity code and by upping the last letter by one.  This is 
NOT the recommended way, but will allow the piece of equipment to parse into 
your machine.  You will have to ensure the entity code you choose is not in use 
by another piece of equipment. But most important, if you are sending this piece 
of equipment to another ASAS, they too must have the same entity code for the 
same piece of equipment to be handled properly by their ASAS-RWS. But the 
true Bottom line is, Do it the right way from the start.  
 
Step12: Click Done button.  
 
Step13: To update or delete an entity select the Selected pull down menu, 
highlight the entity you want to update or delete and select the desired command.  
BE SURE of what you want to delete, once deleted it is gone!  
 
Step14:  After you have made changes to the equipment or equipment alias 
tables, they must be activated. This is done from the file pull down menu. Then 
select “Activate”. If you do not active the table, the changes will not be 
recognized by the system.  
 
 
Create/Update/delete an alias entry:   Back to Top 
 
 This is used to add an alias for equipment in the list.   After creating a new piece 
of equipment you will need to create a list of aliases for that particular piece of 
equipment. Aliases are created to ensure an equipment type will parse a data 
record into the database. Aliases are alternate names for a piece of equipment 
that could be used by soldiers while writing reports.  For example your table calls 
a tank a T-72, the soldier writes T72  (no dash) in the SALUTE report. This 
message would fail to parse that equipment into the equipment database without 
operator intervention.   
 
Step 1: Either click DBM FI identifier in banner or double click the DBM FI 
identifier in the CDE.  
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Step 2: Double click the Table Maintenance Tools option.  
 
Step 3: Double click Entity Hierarchy Maintenance option.  
 
Step 4: Click to highlight desired Entity Type entry.  
 
Step 5: Click on the 'Selected" pull down menu and left click on the 'Open' 
selection. This opens the Equipment file. Or you can run a query for the type of 
equipment you want to edit and then double click on the on the equipment listed 
in the query result. This will also open the equipment file.  
 
Step 6: Type the alias name in the appropriate field. Alias names are created in 
anticipation of different ways a piece of equipment can be input into a message. 
For example; A T-72 can be T 72, T72, T72TK, etc.  Fill in classification 
information by typing the letter u followed by three spaces and then the letter c. 
Or select the box with the three periods and select and validate the appropriate 
classification.  Select the 'add' button to input the alias record. Repeat these 
steps for additional aliases as needed.   
 
Step 7: To exit the process you select done. With this current version, before you 
can select done to end the alias creation, you need to remove any text from the 
'alias name ' field. Or the system will continue to try to update the database with 
that record, and fail because it already exists.  
 
Step 8: To update or delete and Alias, select the equipment type from the entity 
hierarchy table. Open he equipment record. Select by highlighting (double click) 
the alias record you wish to edit or delete.  This fills in the alias fields. Edit or 
delete the file.  
 
Step 9: Select Done.  
 
Step10:  After you have made changes to the equipment or equipment alias 
tables, these tables must be activated. This is done from the file pull down menu. 
Then select activate. If you do not active the table, the changes will not be 
recognized by the system. 
 
 
Perform Query Operations:    Back to Top 
 
Unit: 
 
Step 1: Select “Database Query Operations” from the Common Functions menu 
or from the DBM Functional Identity (FI).    
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Step 2: From the Query pull-down, select "Unit". The Query Unit form displays.  
The Query Unit form is designed to allow you to collect desired unit specific 
information from the CDR tables.  
 
Step 3:  Enter the desired parameters. This form consists of seven main areas of 
data input fields: LOCATION, TIME, UNIT, PARENT UNIT, GENERAL, 
MESSAGE DATA, and TARGET.  Fields with a percent sign (%) next to the label 
allow the use of a wild card function. That is, if you were looking for all units that 
had a designation starting with “INF", you enter “%INF%” into the Organization 
Type field.  The computer will answer your query by showing you all of the 
records that have INF, MECHINF, LT INF, MTRZD INF, etc. No information 
needs to be entered to execute a query.  Simply press Query for all Unit 
information in the CDR database tables and the results are automatically 
displayed in matrix format in the ANL-Database Query Operations-CDR. 
Unit window. 
 
Use the %INF% as an example.   
 

A. LOCATION:  You can select Named Areas, Rectangular Areas, or 
Circular areas.   

1.  Named areas will include NAIs, TAIs, AOIs or DPs created in 
Battlefield Geometry.  You can also use an Area of Query (AOQ) 
that you create in the “Update Area of Query” function that we will 
discuss later. 
2.  When you select Rectangular Area you must enter the lower left 
and upper right MGRS coordinate. 
3.  If you select Circular Area, you must enter a center point in 
MGRS and a radius in kilometers.   

B.  TIME: If you enter a time, it is either a range of time using the full DTG 
or a search during the last hours and minutes. 
C.  UNIT:  Number, Organization Type, and Identification (ID) may use a 
wildcard (%).  If you enter Echelon, Role, or the Echelon range it must be 
exact.  No wildcards can be used here.  The Echelon range is used to 
search for a range of units like BN through DIV. 

           D.  PARENT UNIT:  Same type information as Unit ID. 
E.  GENERAL:  If you select Entity Code, Activity, or Master Key you can 
use the wildcard character.  All other data entered in any other field will 
only produce results for an exact match 
F.  MESSAGE DATA:  You can enter specific parameters to search the 
database for records created from a specific originator or exercise. 
G.  TARGET:  This block will probably never be used for queries and 
deals with specific target values. 

 
*Note* 
The forms query uses “and” logic in its queries.  That is, as you enter more and 
more criteria, the search becomes more specific.  For example, if you query for 
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information that meets criteria unit, time, and location, then information that does 
not perfectly match all three of these criteria will be discarded in the search. 
Aliases can be used alleviating the need of knowing the full name of the 
equipment or unit type.  
Step 4:  Select the “Query” button.  The results are automatically displayed in 
matrix format in the ANL-Database Query Operations-CDR Unit window. 
 
 
Facility:       Back to Top 
 
Step 1:  From the Query pull-down, select “Facility”.   
 
Step 2:  Enter the desired information to set specific query parameters. This form 
consists of six main areas of data input fields: LOCATION, TIME, FACILITY, 
GENERAL, MESSAGE DATA, and TARGET.  All parameters must be found for 
query results to be returned.  Information entered into these fields is the same as 
in the Unit query. 
 
Step 3:  Select “Query”. 
 
 
Equipment:       Back to Top 
 
Step 1:  From the Query pull-down, select “Equipment”. 
 
Step 2:  Set the specific query parameters, i.e., TANK, T-62, MDM. This form 
consists of six main areas of data input fields: LOCATION, TIME, EQUIPMENT, 
GENERAL, MESSAGE DATA, and TARGET.  All parameters entered as "Search 
Criteria" will be found if query results apply.  To make a general query, type in 
%T-62%. 
 
Step 3:  Select “Query.” 
 
 
Various Database Query Operations 
options and common tasks:    Back to Top 
 
Step 1:  Run a query. 
 
Step 2:  Select "Save" from the File menu. 
 
Step 3:  Select the "Query" from the Save menu. 
 
Step 4:  Enter a name for the query.  The name should be descriptive.  I.E. if the 
query is for tanks units name it "Tank". 
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Step 5:  Select "OK". 
 

Using Save As:        Back to Top 
 
Saves previously saved Query, AOQ, or query result with a new filename.  This 
function provides the ability to save a previously saved file with a new, unique 
name.  Once this has been completed, the data can be modified and 
manipulated for other uses. 

 
Step 1:  From the File menu, select "Save As". 
 
Step 2:  From the Save As menu, select "Query". 
 
Step 3:  Select the query you want to change the name of. 
 
Step 4:  Enter the new name. 
 
Step 5:  Select "OK". 
 
Open:        Back to Top 
 
Displays a cascade menu that allows you to open previously defined and saved 
Queries, saved Results of previously executed queries, or AOQs that have been 
constructed and saved. 

 
Step 1:  Select "Open" from the file menu. 
 
Step 2:  Select "Query" from Open menu. 
 
Step 3:  Select the name of the query you want to open. 
 
Step 4:  Select "OK". 
 
Step 5:  Condition window opens 
 
Step 6:  Select “OK” 

 
Delete:         Back to Top 

 
Step 1:  Select "Delete" from the File menu. 
 
Step 2:  Select "Query" from the Delete menu. 
 
Step 3:  Select name of query to delete. 
 
Step 4:  Select "OK". 
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Printing:         Back to Top 
 
Step 1:  Select "Print" from the File menu. 
 
Step 2:  Select "Query" from the Print menu. 
 
Step 3:  Select name of query to print and "OK". The Hardcopy Label Options 
window opens. 
 
Step 4:  Set the print job parameters you want. 
 
Step 5:  Select "Print". 

 
Mail:         Back to Top 
 
Allows you to mail Queries and the Results of Queries to other users' accounts 
on the same machine or any other user on a multi-node system. 

 
Step 1:  Select "Mail" from the File menu. 
 
Step 2:  Select "Query" from the Mail menu. 
 
Step 3:  Select name of query to mail. 
 
Step 4:  Select recipient. 
 
Step 5:  Select "Send". 
 
 
Plotting Queries:       Back to Top 
 
Plots a selected row or rows (database entities) to a user-defined map for further 
review and analysis. The plotting function will automatically open your default 
map if it is not already opened.   

 
Step 1:  Run a query. 
 
Step 2:  Select one or more rows from the query results. 
 
Step 3:  From the “Selected” pull-down select “PLOT” 
 
Step 4:  Select "Center Map" from the Selected pull-down to center the map on 
the entities you have plotted. 
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Step 5:  To highlight the entity on the map, select the row of the entity you want 
to highlight. 
 
Step 6:  Select "Highlight" from the Selected menu.  The entity will be displayed 
on the map with a white border.  This is useful when trying to find a particular 
entity from a cluster plotted on the map. 
 
Step 7:  To remove entities you have plotted, highlight the row and select 
"Remove Plot" from the “Selected” pull-down. 
 
 
Plotting Queries by Color or Size:     Back to Top 
 
This function allows you to change the color or size of the symbol used when you 
plot entities from Database Query Operations.  When this function is selected, it 
will automatically open your default map if it is not opened. 
 
Step 1:  If you want to change the size or color of the symbol to plot, select "Plot 
by Color/Size" from the “Selected” menu. 
 
Step 2:  Select the size and color you want.   
 
Step 3:  Select "Plot". 
 
 
Setting Fields to Display:     Back to Top 

 
Step 1:  From the “Display” select “Fields”.  The Choose Columns window 
displays.  This window allows you to specify database fields to be displayed in 
the results matrix for the query that you just completed.   The Choose Columns 
window is divided into two parts: Available Columns and Columns to Display.   
 
Step 2:  Highlight a field and use the arrows or double click the left track-ball 
(LTB) to transfer fields between windows until you have the desired fields in 
“Columns to Display”.   
 
Step 3:  Highlight field in “Columns to Display” and use the arrows to move the 
selection up/down until the desired location has been reached.  This can also be 
performed by the sequence of data transferred from the Available to the Display 
column.   
 
Step 4:  Once satisfied with your selections, press the “Apply” button to save 
these settings for future CDR Unit results displays.  
 
Step 5:  Re-run your query to show the results in your customized format.  
 



 51

Setting Sort Fields:      Back to Top 
 
You can sort the rows of your database view by choosing the Sort function. The 
rows are sorted by the attributes of a particular column. You can choose multiple 
columns to sort your database view. 
 
Step 1:  From the “Display” menu, select “Sort”.  The Sort window displays.  This 
function determines which database fields will be used to sort the display of the 
entity records in the results matrix.  The Sort window displays two columns of 
data, Available columns and Sort By.   
 
Step 2:  Transfer sort fields between columns using the arrow keys or double 
clicking on the field name.   
 
Step 3:  Set the sort order by selecting fields from the “Sort By” column and move 
them up or down with the arrow keys.   
 
Step 4:  Select the “apply” and "OK" button. 
 
Step 5:  Re-run your query to show the results in your customized format. 
 
 
Creating an Area of Query (AOQ):   Back to Top 
 
Step 1:  Run a query. 
Step 2:  From the “Edit” menu, select "Update AOQ".  This window defines a 
geographical area used as a parameter for queries.  Contains fields for the AOQ 
Name and provides the ability to create a rectangular or circular AOQ. 
 
Step 3:  Enter the AOQ name in the AOQ name field. 
 
Step 4:  Select "Rectangular" or "Circular" button.  For the purpose of this 
demonstration, select "Rectangular".   
 
Step 5:  Enter the Lower Left and Upper Right MGRS grid coordinate.  If you had 
selected circular, you would enter the center point and a radius in kilometers.  
(This is done by left clicking on the map, highlighting coordinate form window, 
and middle clicking to input data) 
 
Step 6:  Select "Done" button. The Update AOQ window closes. 
 
Step 7:  From the File menu, select "Save". 
 
Step 8:  Select "AOQ" from the Save menu.  The AOQ will be saved for later use. 
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Running a Query with an AOQ:    Back to Top 

 
Step 1:  Run a query on units. 
 
Step 2:  From the Unit Form display, select "AOQ" from the “Area Type” pull-
down select the "Named Area" radio box. 
 
Step 3:  Select the name of the AOQ you want to use from the  
“selectable areas” window. 
 
Step 4:  Fill in any other query parameters. 
 
Step 5:  Select the "Query" button. 
 
 
Running queries on the EDC, FRENSIT 
and Incoming Reports tables:    Back to Top 
 
EDC Query:  
 
Step 1:  From the “Query” pull-down, select “EDC”. 
 
Step 2:  Select “Unit”, “Facility”, or “Equipment” from the EDC menu. 
 
Step 3:  Set the specific query parameters. This form is similar to the form 
described above for performing Form Based Queries.  The significant difference 
on this form is that you have the ability to search the database for information 
from a specific RWS by specifying the appropriate designator in the Source 
Enclave data field in the Message Data Input area.  You have the capability of 
running a query on two different units at one time.  However, the same time and 
location is used for both queries.   
 
Step 4:  Select “Query”. 
 
 
Incoming Reports:      Back to Top 
 
 The Incoming Reports portion of query operations is available for processing 
queries against information contained in the Parsed Database.  Information 
entering the system is immediately parsed (if the message is parsable) and 
temporarily stored in the Parsed Database.  The process is very similar to Forms 
Based Queries except that the system pulls the information from PDRs instead of 
CDRs.   
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Intel:         Back to Top 
 
Allows you to query PDRs from parsed, intelligence reports in the system, i.e. 
TACREP and SAUTE reports.  This form only allows you to query for a single 
entity. 
 
Step 1:  From the “Query “pull-down, Select “INCOMING REPORTS” 
 
Step 2:  Select “Intel” from Incoming Reports menu. 
 
Step 3:  Set the specific query parameters.  This form consists of five main input 
fields:  LOCATION, TIME, UNIT/EQUIPMENT/FACILITY, TARGET and 
MESSAGE DATA. 
 
Step 4:  Select “Query”. 
 
 
EDC:        Back to Top 
 
This form is essentially a combination of the EDC Unit, EDC Facility, and EDC 
Equipment windows described above.  The difference is that you run your query 
against PDRs instead of CDRs. 
 
Step 1:  Select “EDC” from the Incoming Reports menu. 
 
Step 2:  Set the specific parameters for your query.  The form consists of five 
main input fields:  LOCATION, TIME, UNIT/EQUIPMENT/FACILITY, TARGET, 
and MESSAGE DATA.  Additionally, this form only allows you to query for a 
single entity type. 
 
Step 3:  Select “Query.” 
 
 
Generating Messages from Database Query Operations.   c 
 
Step 1:  Run a query. 
 
Step 2:  Select one or more rows/entities. 
 
Step 3:  From the “Selected” menu, select "Generate Message". 
 
Step 4:  Select message type.  Everyone select SALUTE for this demonstration.  
A destination window will open. 
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Step 5:  Select the destination/destinations or group to transmit message.  
Everyone will select the SALUTE group for this demonstration. 
 
Step 6:  Select "Done".  The message will open in an Immediate Review window 
for final review. 
 
Step 7:  Review and make any required changes to message. 
 
Step 8:  From the Message pull-down, select “Transmit” (or select the "Envelope" 
icon). 
 
 
Reviewing Messages:     Back to Top 
 
This capability allows you to review the received message, and its original 
content.  This is beneficial if you have questions or concerns about the 
information in the database record.  You can review the entire message and see 
what other information was reported in the message, and get some sort of idea 
as to the potential for errors when the data was reported.   
 
This function is available for all PDR query results, but not from the CDR 
query results. 
 
Step 1:  Run a Query from Incoming Reports, (Intel). 
 
Step 2:  Select an entity from the results window. 
 
Step 3:  From the Selected pull-down, select “Retrieve Message”.  The On-Line 
Message Journal window displays.  The message that generated this entity will 
display in the window.   
Step 4:  Select “Exit” from the File menu. 
 
 
Manually input information into the       Back to Top 
ASCDB using the Create Entity Intel Long Form 
 
Step 1: Select the “Database Query Operations” from the Common Functions 
pull-down. 
 
Step 2: When the window appears, pull down the "Entity Creation" menu. 
 
Step 3: Select "Intel (Long Form)".  The "Create Intel Report" Long form will 
appear. 
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Step 4:  Set the Base Type.  The Base Type is Unit, Equipment, or Facility.  
Setting the base type will set the proper database fields displayed on the creation 
form for each particular base type.  
 
Step 5: Fill in the following mandatory fields.  Mandatory fields are denoted by 
the | (pipe) symbol.  If the system does not recognize a value, it will refuse to 
accept it once you tab to the next field and an error symbol will appear next to the 
field.  If this happens, that value will have to be normalized. 
 
 
The mandatory fields for unit are: 
A. Number, such as 11.   
B. Organization Type, such as MR .   
C. Echelon Level, such as Div .   
D. Allegiance  This value is related to the country code of the entity.  
E. R for Real or I for Inferred.  R is the default.  When you use Inferred the 
symbol will plot with a dashed line. 
F. Location, such as 32UNB2020.  This field is not mandatory, but should be 
entered if the information is available. Keep in mind, if there is no coordinate, 
then the symbol will not plot to the map. 
G. Role, such as COM for combat unit. This field will automatically fill based on 
the unit type that is input.  The other unit types that will be filled in this field are 
CSU, for Combat Support Unit (such as combat Engineers, Air Defense Artillery 
or Military Intelligence), and CSS, for Combat Service Support (such as 
Personnel, Finance, or Food Services). UNK for an unknown unit type is also 
available.  You can also designate that a unit be plotted with the staff showing it 
as a command post.  To do this you would input RCP for Rear CP, FCP for 
Forward CP, and MCP for Main CP in the role field. 
 
H. Time - The current system time is entered, but can be edited if the time 
of information is different from the system time. 
 
The mandatory fields for equipment are: 
A. Equipment Name - The name of the equipment as reported. 
B. Allegiance. 
C. R for Real or I for Inferred.   
D. Location, such as 32UNB200200.  This field is not mandatory, but should be 

entered if the information is available. Without a location the symbol will not 
plot to the map. 

E. Time. 
F. Quantity.  Not a mandatory field for equipment inputted in the database, but is 

a mandatory value for sending messages created from the database. 
 

The mandatory fields for facilities are: 
A. Facility Name - The name of the facility as reported. 
B. Allegiance. 
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C. R for Real or I for Inferred.  R is the default. 
D. Location, such as 32UNB2020.  This field is not mandatory, but should be 

entered if the information is available for the same reasons listed above. 
E. Time. 
 
Step 7:  Fill in any of the other fields. 
 
Step 8: Press the "Done" or "Apply" button.  The system will check the 
information you entered to ensure that at least the above values have been filled 
in and normalized.  If there are problems, a message window will appear.  If not, 
then the fields will clear.  If you selected the “Apply” button, the form will remain 
open for a new record. 
 
 
Manually inputting information into the  
ASAS RWS databases using the entity    Back to Top 
creation short form. 
 
Step 1: Select “Database Query Ops” from the Common Functions pull-down.   
 
Step 2: When the window appears, pull down the "Entity Creation" menu. 
 
Step 3: Select "Intel (Short Form)".  The "Create Intel Report" short form will 
appear. 
 
Step 4:  Set the Base Type.   
 
Step 5: Fill in the mandatory fields.  
 
Step 6: Press the "Done" or "Apply" button.  The system will check the 
information you entered to ensure that at least the above values have been filled 
in and normalized.  If there are problems, a message window will appear.  If not, 
then the fields will clear.  You can then enter another set of information if you 
selected “Apply”. 
 
 
Creating friendly entities using the      
FRENSIT Entity Creation function.     Back to Top 
 
Step 1:  From the Entity Creation menu, select “FRENSIT”. 
 
Step 2: In the ID field type the name of the unit that is to be created.  Once the ID 
field is filled with a unit ID (e.g.  101ST CHEM CO) the other fields will 
automatically be filled with the necessary data. Alternatively, you may enter the 
Unit Identity Code (UIC) and the Unit ID field will automatically populate. 
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Step 3: In the Location field type the location of the entity. 
 
Step 4:  Select “Done”. 
 
 
How to manually edit and update records in the ASCDB.   Back to Top 
 
Step 1:  Run a query. 
 
Step 2:  Click one or more rows to highlight entity. 
 
Step 3:  From the Display menu, select “Record”. 
 
Step 4:  Make changes to the record.   
 
Step 5:  Click “Apply”.  Saves the changes to the current record. You may use 
the arrows at the bottom of the form to access more records if multiple records 
were selected. 
 
Step 6:  Click “Done” in the Display Unit window to exit. 
 
 
Construct Map Symbol data     Back to Top 
 
Step 1: Select “Map Functions” from the Gray Banner. 
 
Step 2:  Select "Entity Characteristics". 
 
Step 3:  Select the type of entity these defaults will apply to, “Unit”.  Choices are: 

A. Unit. 
B. Equipment. 
C. Installation. 

       D.  FOB 
 
Step 4:  Set the General Characteristics of the symbol to be plotted. 

A. Symbol size.  Choices are Echelon, Small, Medium, Large and Extra 
Large.  The echelon option is applied specifically to units.  It will 
automatically size the symbol to match the unit size: company (small), 
battalion (medium), regiment (large), division, corps and armies (extra 
large). 

B. Target Status, On or Off.  Target Status determines whether the ball, 
rectangle, or triangle target symbols are displayed above the icon when 
plotted. 

C. Error Ellipse, On or Off. 
     D.  Ellipse Thickness, Fine, Medium or Heavy 
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Step 5:  Set the “Entity Field Characteristics” by toggling On or off the following 
buttons for unit symbols.  A check will display if on.  Only the highlighted fields 
are available as options. Enable only those items expected to be useful. Once 
plotted to the map, fields may be turned off/on through the Entity Operations 
Entity Characteristics function. 

A. Size indicator. 
B. Date/Time Group of the information. 
C. Unique Designation (unit name or number). 
D. Headquarters - will display simple with staff. 
E. Direction arrow - will display below the symbol. 
F. Higher formation - (parent unit). 

 
Step 6:  There are two optional choice buttons to the right of the rectangle.  
These buttons can be set to any of the values hidden beneath the buttons.  For 
our training we will set the upper one to "Unit Org Type" and the lower button to 
“Unit Strength Curr”.   
 
Step 7:  Select "Done" or "Apply".  The changes will be active in the next plot 
from the database or Database Alerts from Criteria. 
 
 
Configuring Equipment Symbols   Back to Top 
 
Step 1:  Select "Entity Characteristics". 
 
Step 2:  Select the type of entity these defaults will apply to, “Equipment”. 
 
Step 3:  Set the General Characteristics of the symbol to be plotted.  I.E., symbol 
size; Target Status, On or Off; Error Ellipse, On or Off; and Ellipse Thickness, 
Fine, Medium or Heavy 
 
Step 4:  Set the Entity Range Characteristics. This set of pull-downs are used to 
turn off/on the maximum, minimum, and maximum effective ranges for entity 
types (Units, Equipment, Installations, and FOB) and to set range line thickness 
(Fine, Medium, or Heavy) for each range. 
 
Step 5:  Set the “Entity Field Characteristics” by toggling On or off the following 
buttons for equipment symbols.   
A. Size.   
B. Quantity.   
C. Date/Time Group. 
D. Unique Designation. 
E. Headquarters. 
F. Direction arrow. 
G. Role indicator. 
H. Plus 3 optional choice buttons, which will display none if they are disabled. 
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Step 6:  Select "Done" or "Apply".  The changes will be active in the next plot 
from the database or Database Alerts from Criteria. 
 
 
Configuring Installation Symbols    Back to Top 
 
Step 1: Select "Entity Characteristics". 
 
Step 2:  Select the type of entity these defaults will apply to, “Installation”. 
 
Step 3:  Set the General Characteristics of the symbol to be plotted.  I. E., 
Symbol size; Target Status, On or Off; Error Ellipse, On or Off; Ellipse Thickness, 
Fine, Medium or Heavy 
 
Step 4:  Set the “Entity Field Characteristics” by toggling On or off the following 
buttons for installation symbols.   
A. Size. 
B. Date/Time Group. 
C. Unique Designation. 
D. Headquarters. 
E. Direction arrow. 
F. Role indicator. 
G. Plus 2 optional choice buttons. 
 
Step 5:  Select "Done" or "Apply".  The changes will be active in the next plot 
from the database or Database Alerts from Criteria. 
 
 
Conduct Entity Operations   Back to Top 
 
Step 1:  Select “Database Query Operations” from Common Functions. 
 
Step 2: Perform a Forms Based Query.  This function allows the analyst to either 
query all information in a database, or set parameters for the information he is 
requesting.   

A. In the "Database Query Operations" window, select "Query." 
B. Under "Query", select "Unit", "Equipment", or "Facility.  We will use "Unit" 

for the purposes of this training. 
C. If you wish to see all entries in your database, press the “Query" button at 

the bottom of the window. The system will display all information in the 
database. 

D. Enter the desired information to set parameters. 
E. Select “Query”.   

 



 60

Step 3:  Highlight the entities you wish to plot by clicking on the box to the left of 
the entity. 
 
Step 4:  Under “Selected”, select “Plot”.  This brings up the default map that you 
created if a map is not already opened.  It may not be the map the entity is 
plotted on.  Use center map to go to the correct map. 
 
Step 5:  To center the map to the entity: 

A. Highlight one entity in “Database Query Ops”.   
B. Under “Selected”, select “Center Map”.  The displayed map will be brought 

up adjusted so that the center of your map is focused on the selected 
entity. 

 
 
Combining two or more entities on the map    Back to Top 
 
Step 1:  Select the entities you wish to manipulate: 

A. To manually choose a single entity, click on the icon with the LTB.    
B. To manually choose multiple entities, hold down the control button, and 

click on the icons.  They will highlight. To manually choose a group of 
entities, click and hold the LTB and drag the cursor across the group.  
Release the LTB to highlight the entities you swept. 

C. To select entities automatically using a criteria: 
1. Click the right track-ball (RTB) on the map background.  The “Entity 

Operations” menu will appear. 
2. Under “Operations”, select “Select Entities”.   
3. Enter the specific information requested on the “Select Entities” 

window.  The user may select entities using the following criteria:   
(a) All or individual entity types. 
(b) All or individual colors, allegiance, organization type, echelon, 

keywords, geographic area, and entity sets.    
(c) The logic operator "and" is used to define the relationship between 

the criteria.  For example, if the user chose Entity type - Unit, Color 
- Red, 
Organization Type - MR, Echelon - BN, all red MR BNs plotted on 
the map will be highlighted and will appear in the Entity Operations 
window.   

(d) The Geographic Area allows the user to select which open map 
window to apply the criteria to as well as limit the selection to just 
the part of the map which currently appears in the window.    

(e) The Selection by Entity Sets allows the user to select entities are 
defined on specific overlays.   

(f) There is also a Select All Entities option at the top of the form. 
4. Click “Done”. 
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Step 2: Click the RTB on the map background.  The “Entity Operations” window 
will appear.  
 
Step 3: Left-click to highlight two or more entities. 
 
Step 4: From the Database pull-down menu, select “Combine Entities”.  The 
Combine Entities window will open with the selected entities in the display list. 
 
Step 5: From the Combine Entities window, choose “View”.  Displays the View 
menu options, these are Unit, Facility, Equipment and All. 
 
Step 6:  Select the view to be applied.  Displays the Default field columns for the 
selected view along with the appropriate data for Equipment, Facility, Unit and 
All. 
 
Step 7:  Click the “Set Fields” button.  Displays the Set Fields window with the 
current field defaults in the right column and the other fields you have the option 
of viewing. 
 
Step 8:  Perform one of the following options to select fields for display. 

A. Select the field name from the Available Fields column (Left).  You can 
use the Control or Shift keys to select multiple fields at a time. 

B. Click the right arrow button to copy field from Available Fields column 
to Selected Fields column. 

C. OR… Double-click a single field name and the system will move it to 
the Selected Fields column. 

D. OR… Select the field name from the Available Fields column and then 
hold the CTB to drag the field name to the Selected Fields column. 

E. If you wish to view all the fields, click the “Select All” button. 
 
Step 9:  Perform one of the following to remove items from the Selected Fields 
column. 

A. Click the Clear button.  Removes all fields in the Selected Fields 
column. 

B. OR… Select the field name from the Selected Fields column. 
C. Click the left arrow button.  Removes selected field name from the 

Selected Fields column. 
D. OR… Double-click a single field name from the Selected Fields 

column.  Removes selected field name from the Selected Fields 
column. 

E. OR… Select the field name from the Selected Fields column.  Click the 
CTB and drag the field to the Available Fields column.  Removes 
selected field name from the Selected Fields column. 

 
Step 10:  Click the “Done” button to Apply changes.  Accepts changes, closes the 
window, and the new columns are displayed in the “combination will not be 
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allowed. If you still believe them to be the same object, you must select one and 
change the record (Selected menu, Edit Entity selection) before continuing. 
 
Step 11: Select two or more entities from the “candidates” display list.  You would 
normally select units that are very similar (for instance two UI armor squads) or 
two entries for the exact same unit.  
 
Step 12:  Click the “Combine” button or select the “Combine” option from the 
Selected menu.  The Combination result will display in the Combined Result 
display area. 
 
Step 13:  Review Combined Result and edit as required.  Edit the information 
directly by placing the cursor in the field to be edited and make appropriate 
changes. 
 
Step 14:  Select the “Accept” button or from the File menu, select “Accept” to 
accept the combination results.  The database will be updated, including the 
history/audit trail.  If errors exist in the combined result, the Combine Entities 
Entry Errors window will display.  All errors listed must be rectified before 
continuing. 
 
 
Combining Entities from Database Query Operations  Back to Top 
 
Step 1:  Run a query to populate the Query Results display. 
Step 2:  Using the control key and the left track-ball button, select two or more 
entities from the Query Results display while holding.  Click the box to the left of 
the row(s) that you want to select for combination. 
 
Step 3:  From the Selected menu, choose “Combine Entities”.  The Combine 
Entities window will open with the selected entities in the display list. 
 
Step 4:  The rest of the steps are the same as Steps 5-14 from above.  The only 
difference is accessing the function from Database Query Operations or Entity 
Operations. 
 
 
Other Window/Menu Options in Combine Entities   Back to Top 
 
1) Selected Menu. 
     A.  Clear Candidate: Removes the selected entity(s) from the display list, but 
does not delete the entity from the database.  Re-selection from either the map 
or Database Operations will allow the analyst to place the candidate back on this 
list. 
     B.  Edit Entity: Opens the database record for a single selected entity to 
manually enter changes. 
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C.  Entity History: Opens the Entity History window so you may view the entire 
combination history for a single selected entity.  Displays the History/Audit Trail 
data associated with the selected entity. 
D.  Print: Displays the Print Fields window where you may choose which fields to 
include in the printout. The Done button executes the print job and closes the 
window. 
2) Map Menu. 
A.  Plot Candidate(s): Plots the selected candidate(s) to the map with the proper 
military symbology.  Prior to plotting any information, a TEM Map window must 
be opened using Map Window Management. 
B.  Remove Candidate Plot(s):  Removes the plotted symbols for the selected 
candidate(s), but does not remove them from the candidate list or the database. 
C.  Highlight Candidate(s) on Map:  Reverse highlights the entity(s) selected from 
the display list on the map. 
D.  Recenter Map on Candidate:  Recenters the map background display on the 
candidate selected. 
E.  Plot Result:  Plots the result to the map using standard military symbology at 
the location currently set by the user. 
F.  Remove Result Plot:  Removes the plotted symbol for the result. 
G.  Highlight Result on Map:  Reverse highlights the result from the display 
window on the map. 
H.  Recenter Map on Result:  Recenters the map background display on the 
result. 
I.  Reverse Highlight:  Reverse highlights the entity(s) selected on the map in the 
display list. 
J.  Sweep Entities:  Changes cursor to cross hairs when moved to the map and 
allows multiple selections through the sweep process. 
K.  Click One Entity:  Changes cursor to cross hairs when moved to the map and 
allows you to choose a single entity from the map. 

a. Select Map:  Selects the map to be used when multiple maps are 
active. 

 
Removing Graphics/Entities from the Map:  Back to Top 
 
Step 1:  To remove a graphic or icon from the map, left click on it to highlight it. 
Step 2:  Right Click on the map background to bring up Entity Operations. 
Step 3:  Entity will be highlighted in the Entity Operations Window. 
Step 4:  Select the "Operations pull-down“ and select "Remove Entity Graphic.”  
 
 
Changing Symbol Characteristics:   Back to Top 
 
Step 1:  Right Click on the map to bring up “Entity Operations" after you have 
highlighted the entity. 
Step 2:  Select “Change Entity Characteristics” from the Operations pull-down. 
Step 3:  Make the appropriate changes.   



 64

Step 4:  Select “Done”. 
 
 
Displaying Strength:     Back to Top 
 
Step 1:  Select one or more entities from the map. 
Step 2:  Right click the track ball to bring up Entity Operations. 
Step 3:  Select “Display Strength Assessment” from the Operations pull-down.  
This will refresh the selected units and replot them with the correct colors for their 
strength.   
Step 4:  Select “Done”. 
 
*NOTE*  
You can also update the location of the entity by simply left-click and hold on the 
entity; then right-click to bring up Entity Operations; then click the “DB Update” 
button. 
 
 
Associating two or more  
entities Associating Entities 
from Entity Operations:     Back to Top 
 
 
Step 1:  Select the entities you wish to manipulate using any of the methods 
discussed in Combine Entities. 
 
Step 2: Click the RTB on the map background.  The “Entity Operations” window 
will appear.  
 
Step 3:  Left-click to highlight appropriate entities. 
 
Step 4:  Select “Associate Entities” from the “Database” pull-down.  The 
Associate Entities window will open with the selected entities in the display list. 
 
Step 5:  You may adjust the information that is displayed in the window by using 
the “Set Fields” button.  This function is exactly the same as Set Fields in the 
Combine Entities function. 
 
Step 6:  Select the entity to be designated as the primary from the Selected 
Entity(s) window.  The entity is highlighted in the Selected Entity(s) window. 
 
Step 7:  From the Selected menu, select “Select Primary” or click the “Select 
Primary” button.  The Primary is the entity to which all associates will be 
established.  This entity will display in the bottom half of the window (section 
labeled Association).  
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Example:  Choose a division and associate the non-organic supporting 
units (Corps Artillery, Logistics, etc.).  If an appropriate Primary is not 
available, as may be the case with a Task Force, you must create the 
entity first and then select it as the Primary.  Use the Create Entity button 
to access the Create Entity Long Form. 
 

Step 8:  Select the entities to associate with the primary from the Selected 
Entity(s) window. 
 
Step 9:  From the Selected menu, select the “Add To Assoc” button.  The 
selected entities will display in the list on the bottom half of the screen.   
 
Step 10:  Once you highlight those entities from the list at the bottom of the 
window, a pop-up button displays above the list with relationship choices. 
 
Step 11:  From the pop-up menu select the appropriate relationship, then choose 
Apply.  The button defaults to the most recently chosen relationship. There will 
be no selections available when associating equipment or facilities. 
 
Step 12:  Click “Done”. 
 
 
Associating Entities from  
Database Query Operations:    Back to Top 

 
Step 1:  Run a query on the appropriate units to associate. 
 
Step 2: Select the entities you wish to use in the association.   
 
Step 3:  From the Selected menu, select “Associate Entities”.  
 
Step 4:  The rest of the steps are the same as Steps 5-12 from above.  The only 
difference is accessing the function from Entity Operations or Database Query 
Operations. 
 
 
Disassociating Entities:     Back to Top 

 
Step 1:  Select the Primary entity from the Selected Entity(s) window and click 
“Select Primary” button.  The entity is highlighted in the Selected Entity(s) 
window. 
 
Step 2:  Select one of the associated entities from the Association Window. 
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Step 3:  From the Associate pane, select the “Disassociate” button or select 
“Disassociate” from the Selected menu.  A dialog will prompt you to disassociate 
this unit. 
 
Step 4:  Click “Yes”.  The dialog is closed and the entity is disassociated from the 
primary. 
 
Step 5: Click the “Done” button or select “Done” from the File menu. 
 
 
Viewing Relationships:     Back to Top 

 
Step 1:  Select Entities. 
 
Step 2:  Select “Associate” from the Database pull-down. 
 
Step 3:  Highlight the entity in the Associate window. 
 
Step 4:  Select “View Relationship” from the Selected pull-down.  This will display 
any known associations. 
 
 
Plotting Links and Associations:   Back to Top 
 
Step 1:  Choose a Primary entity from the Selected Entity(s) window.  The entity 
is highlighted in the Selected Entity(s) window.  Click “select primary”. 
 
Step 2:  From the Map menu, select “Plot Primary” or click “Plot Primary” button.  
The associated entity(ies) will display in the Association pane of the Associate 
Entity(s) window and the Primary will be plotted on the Active map window. 
 
Step 3:  Click on an associated entity in the Association pane.  From the Map 
menu select “Plot” or click the “Plot” button.  The related entity(ies) will be plotted 
on the active map. 
 
Step 4:  From the Map menu, select “Plot Link(s)” or click the “Plot Links” button.  
Lines will be drawn between the primary and the associated entity(ies). 
 
 
Collecting and displaying entity history:  Back to Top 
 
Step 1:  Select an entity from the map. 
 
Step 2:  Click the RTB to bring up Entity Operations. 
 
Step 3:  Select “History” from the “Database” pull-down.  The ‘Entity History’ 
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window will appear. 
 
Step 4:  Select done. 
 
 
Displaying Entity History from 
Query Operations:      Back to Top 

 
Step 1: From the Database Query Operation window, click on an entity. 
 
Step 2:  From the Selected menu, select “Entity History”.  The Entity History 
window opens. 
 
Step 3:  From the File menu, select “Done”. 
 
 
Other Window/Menu Options  
in Entity History:       Back to Top 
 
1)  Selected Menu: 

A.  Review Message: Opens the On-line Message Journal with the 
message displayed that created or altered the selected entity. 
B.  Print: Allows you to print the information for a selected entity.  The Print 
Fields window is presented allowing you to choose which fields from the 
entity's record you wish to be included in the printout. 

2)  Map Menu: 
A.  Plot: Plots all entries to the map as locations connected by lines 
showing path of movement.  Last reported entry displays as a unit symbol. 
B.  Remove Plot: Removes all but the latest entry from the map. 
C.  Plot Points Field: Shows the number of points represented for the 
entity. 
D.  Entries Field: Shows the number of history entries for this entity. 
 E.  Set Fields Button: Opens the Set Fields window allowing you to 
choose which fields from the database will be displayed.  Entries are 
moved from the Available Fields column to the Selected Fields column by 
three methods: double clicking on a field name, clicking and dragging a 
field name, or by highlighting a field name and pressing the appropriate 
arrow.  Clicking and dragging a field name to the appropriate place in the 
column listing changes order of display. 

 
 
Perform Overlay Operations:    Back to Top 
 
Step 1:  Select “Run Query” from the Map window.  The Plot Saved Query 
window displays. It lists all the saved queries that are currently available from 
Database Query Operations. 
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Step 2:  Select the query to be executed and select “Plot”.  The Plot Saved Query 
window closes. The database is queried for the data defined by the selected 
query and the results are plotted directly to the map window.  
 
Step 3:  Select “OVMGR” in the upper right corner of the map.  The overlay name 
(QP_queryname_DTG) displays in the Overlay Manager with a Visible status. 
 
Step 4:  To update the query, select the overlay name in the Overlay Manager 
window and pick “Run Query” from the Tools menu.  The database is required 
and the overlay updated. 
 
 
Creating an Overlay:     Back to Top 

 
Step 1:  After you have drawn all of the graphics and plotted all of the entities you 
wish to include in the overlay on the map, place a label in the map window 
containing the title, DTG, unit, and creator of the overlay. 
 
Step 2: Select “Overlay Manager” (OvMgr). 
 
Step 3: Select “Save As” button or  “Save As” from the File menu.  The Save As 
dialog displays.  Existing overlay names must not be highlighted when this step is 
performed because the system will overwrite the current overlay with the new 
overlay. 
 
Step 4: Enter a name for the overlay.  Ensure that it describes the overlay and is 
recognizable to other analysts.  The name cannot contain special characters 
such as %,*,?.  If the name has more than one word, use an underscore (_) 
between words. 
 
Step 5: Select “OK”.  The overlay will appear in the list at the bottom of the menu. 
 
 
Managing existing overlays:    Back to Top 
 
Step 1:  From the Overlay Manager window, select Open.  The Overlay 
Manager-Open Manager window displays.  Your choices are Master, User, 
Shared and Import.  These options provide lists of available overlays that can be 
loaded or opened. Remote is reserved for performing Map Collaborative Overlay 
operations.  
 
Step 2:  Select Master or User.  The overlays that have been saved will appear 
in the window.  
 
Step 3:  Select the overlays you want to load or select all. 
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Step 4:  Select Open, This moves the overlays to the Overlay Manager 
 
Step 5:  To view an overlay on a map, select the “Vis”  (Visible) radio-button for 
that overlay.  A check will appear indicating the overlay is active.  To remove an 
overlay from the map, toggle the “Vis” radio-button again. The overlay will be 
removed from the map and the check will disappear.  You may change an 
overlay from visible to invisible to assist in decluttering the map.  If the contents 
of the overlay are not visible when you select Vis, select the overlay name and 
choose Locate On Map under the Tools menu in the Overlay Manager window. 
This will jump the current map window to the location of the displayed objects 
from this overlay. Some zooming or scale changes may be required to see the 
entire overlay. 
 
Step 6:  Select “Done”. 
 
 
Merging Two or More Overlays:    Back to Top 
 
 You may determine that you no longer need separate overlays or that you wish 
to send a composite picture rather than individual pieces to another ASAS.  
Merging overlays allows you to combine information from two or more overlays 
into a single overlay (still retaining the individual overlays). This capability is 
provided using the Save As command to create a new overlay made from 
multiple selected overlays. 

 
Step 1:  Make the overlays visible on the map.   
 
Step 2:  Highlight the overlay names you want to merge.  Use the Ctrl key to 
highlight more than one overlay at a time. 
 
Step 3:  Select "Save As".  This saves the information as a new overlay with a 
unique name.  
 
Step 4:  Enter new name. 
 
Step 5:  Select “OK”. 
 
 
Deleting Overlays:      Back to Top 

 
Step 1:  From the Overlay Manager select “Open”. 
 
Step 2:  Select User, or Master, to bring up the list of available overlays. 
 
Step 3:  To select multiple overlays for deletion use the Ctrl key. 
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Step 4:  Highlight the name of the overlay in the list. 
 
Step 5:  Select “Delete”. 
 
Step 6:  Select “Yes”, from the confirmation box that displays.  The overlay will be  
deleted.   
 
Step 7:  Select “Done” to exit the Overlay Open Manager. 
 
 
Saving Changes to Existing Overlays:  Back to Top 
 
Step 1:  Highlight the name of the displayed overlay in the Overlay Manager.  
 
Step 2:  Select “Save” from the File menu or hit the “Save” icon.   
 
 
Changing the Name of an Existing Overlay:  Back to Top 

 
Step 1:  Highlight the name of the displayed overlay in the Overlay Manager.   
Step 2:  Select “Save As”.  Enter a new name for the overlay.   
 
Step 3:  Select OK.  This copies the overlay with a new name. 
 
 
Exporting, importing, and archiving overlays: Back to Top 
 
Step 1:  Select an overlay from the Overlay Manager (Highlight Overlay Name). 
 
Step 2:  From the Selected menu, select “Create/Update List”.  The Destination 
Addressing List displays listing all the system names that can receive an Overlay 
Message. 
 
Step 3:  Select System Names (addresses) to send the Overlay.  Each system 
name will highlight as it is selected. Filters may be used if the list of system 
names is too long to sort through. The control key can be held down to permit 
selecting multiple system names. 
 
Step 4:  Select “Done”.  The overlay is sent to selected addresses. An E-mail 
message is sent to each ASAS address selected.  At the recipient's end, these 
messages are available for importing into the Overlay Manager. 
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Exporting Overlays After List is Created:  Back to Top 
 

Step 1:  Highlight the name of the overlay you wish to send in the menu. 
 
Step 2:  Select the “Send.” button.  The overlay will be sent to the previously 
established list.   
 
Step 3:  A dialog box will open saying the overlay has been sent.  Click “OK” to 
dismiss. 
 
Step 4:  Contact the recipients to inform them that you have exported an overlay 
to them. 
 
 
Importing Overlays:       Back to Top 
 
Overlays sent to you by other workstations or locally exported reside in a 
separate directory until you choose to import them. They are treated like a 
message and the import directory is the inbound queue.  When an overlay is 
imported, it is immediately plotted to a map.  It is advisable to clear the map or 
open a new map window prior to importing.  This allows you to review the overlay 
prior to making it a part of your battlefield picture 
 
Step 1:  From the Overlay manager select “Open”.   
 
Step 2:  In the Overlay Manager-Open window select the “Import” button.   
 
Step 3:  From the list that appears, highlight the overlay you wish to import. 
 
Step 4:  Select “View”.  The overlay will display on your map and will move to the 
Overlay Manager. 
 
Step 5:  Select “Open” to move the overlay to the Overlay Manager but to not 
display it. 
 
 
Archiving Overlays:       Back to Top 

 
Step 1:  Export the overlay using your address as the recipient.   
 
Step 2:  The overlay will be sent to the following file directory:  
/home/users/overlay/Overlays.  This is also the directory where all overlays 
imported from other systems are kept. 
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Step 3:  Utilize the FTP function to move the files in this directory to a file 
directory designated by your system administrator as the archive. For this class, 
we will use the /home/users/overlay/Overlay directory. 
 
 
Accessing Map Collaborative Overlays:  Back to Top 
 
Step 1:  Create an overlay with 5 units and 2 graphics using free draw at 
11SNV28560206. 
 
Step 2:  Save the overlay using your 'unitname'_DTG as the title.   
 
Step 3:  Clear the graphics. 
 
Step 4:  Display the overlay in the Overlay Manager. 
 
Step 5:  On the radio buttons for the overlay, select the “Share” function by  
selecting the “ ”  button. 
 
Step 6:  Bring up your partner machine’s MCO list.  Display his newly created 
MCO. 
 
Step 7:  Move some of the entities and graphics on your maps. 
 
 
Steps for Recipients:     Back to Top 

 
Step 1:  Create a map and title it instructor.  In the future, you should have a 
separate map for each MCO you will be accessing.  This will aid you in keeping 
straight which information is yours and where the other information is coming 
from.   
 
Step 2:  Go to coordinate 11SNV28560206.  Normally you would already know 
the area, but for instruction we will use the area around this coordinate. 
 
Step 3: “Ovmgr”.  Select “Select Open to bring up the Overlay Manager - Open 
window. 
 
Step 4:  Select “Remote”. 
 
Step 5:  Select the host name for the system you wish to receive MCO’s from.  
The COM destination address window displays. Type in the name for the system 
match or select the address from the list.  Click Apply.   
 
Step 6:  A list of the shared (MCO) overlays on that system will appear. 
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Step 7:  Highlight the name of the overlay. 
 
Step 8:  Select “View”.  The overlay will display on your map and the title of the 
overlay will appear in your overlay manager with the “Vis”, and “MCO” radio 
buttons grayed.  This is done so you can visually identify those overlays that do 
not reside on your system.  The source’s hostname and overlay name both 
appear in the in the Overlay Manger.  As the instructor moves elements on his 
map, you will see the elements move on your map. 
 
 
Adding Entities to MCOs:      Back to Top 
 
This step is for the source.   

 
Step 1:  Add another entity of the appropriate color using free draw.   
 
Step 2:  Look at your partner machine.  The new entity does not yet appear on 
his map yet. 
 
Step 3:  Highlight your MCO in the Overlay Manager. 
 
Step 4:  Select the “Save” button. 
 
Step 5:  Look at your partner’s machine again.  The new entity will appear.  The 
entity does not appear when you create it on your map.  Until you save it, it only 
exists on the “Free Draw” layer of the map, not the overlay.  Saving it allows the 
system to transmit the change to the partner machine. 
 
 
Updating the Database from a MCO:    Back to Top 
 
 Both the source or the recipient of an MCO can update their respective database 
from the MCO.  It is as simple as using Entity Operations. 

 
Step 1:  Select the entities you want to update. 
 
Step 2:  Right click on the map to bring up Entity Operations. 
 
Step 3:  Select the “DB Update” button to update the ASCDB.  This will only 
update the database on your system.   Both sides will have to use Entity 
Operations to update their ASCDB.  If you have an entity in Entity Operations 
with CDR? Displayed, this means that the entity has been updated on the other 
end of your shared overlay.  You can then elect to update your database or leave 
it the same. 
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Saving a MCO to your System:    Back to Top 
 

Step 1:  Highlight the overlay you wish to save by clicking the LTB on the name 
of the overlay in the Overlay Manager. 

 
Step 2:  Select the “Save As” button on the Overlay Manager. 
 
Step 3:  Type in a new name for the overlay that is now resident on your system.  
This will give you a copy of the MCO overlay.  This does not unload the MCO 
overlay.  If the MCO overlay is disconnected you can bring up your copy of the 
overlay. 
 
 
Conducting Work in the same Area as a MCO:   Back to Top 
 
Normally both of these overlays will be in red, not color coded to separate the 
information.  This could create confusion as to which entities are yours and which 
are from the other system.  You may want to use multiple maps to work with 
MCO.  To do this: 

 
Step 1:  Create a map named “Instructor”. 
 
Step 2:  Load the MCO from the instructor’s system. 
 
Step 3:  Go to the Map Window Manager and create a map named “Local”.  
Make it the same location, scale, and zoom factor as the instructor map. 
 
Step 4:  On the local map, select “Overlay Controls”.  This does not bring up a 
second overlay control menu, but it does give control of the menu to the local 
map.  Notice that the radio buttons on the instructor MCO are no longer lit, but 
the MCO is still visible on the instructor map, and changes are still occurring.  
The link with the source system is still active. 
 
Step 5:  Select the “Vis/Act/Shr” radio buttons on your overlay.  They will appear 
on your map.  This way you can have your own situation map up while 
monitoring the analysis of the other analyst.  You can monitor several maps at 
once.  For example, the analyst at division could have a MCO active for each of 
his brigade systems, and could share his MCO with each of these machines. 
 
 
Conduct Interactive Message Generation:  Back to Top 
 
Step 1:  Select the Common Functions, the SIT FI on the toolbar, or the Common 
Desktop Environment.  
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Step 2:  Select the "Interactive Message Generator" by double clicking on the 
CDE icon. (SIT – Interactive Message Generation window opens) 
 
Step 3:  Under "Message", select "New" or select the first icon button (looking like 
a can).  The "User Messages Selection" window will appear.   

 
NOTE:  The RWS contains two message lists:  a user message list for messages most often 

used by the analyst, and the system message list: containing all messages within the 
system.  User lists can be deleted and added, but this does not affect the system 
message list. 
 

 
Step 4:  Select the message type you wish to create.  You can search for a 
specific type of message using the search bar at the bottom of the page.  Some 
examples are: 
 (a)  S303 – SALUTE   
           (b)  C111 - TACREP (Threat Alert) 

(c)  S305 - TIDAT (Target Nomination) 
           (d)  S302 - Free text  (Does not parse) 
Once you highlight the message type, the row will highlight. 
 
NOTE:  Typing the message name or number in the fields at the bottom of the 
window and tabbing will also highlight the appropriate row.  
 

Step 5:  Select the SALUTE mask. Press "OK".  The message mask will appear.  
Step 6:  The lines and fields will be color-coded: 

(a)  Orange = Mandatory 
(b)  Turquoise = Optional 
(c)  Purple = Conditional 
(d)  Red = field entry Error 
(e)  White = None 

 
  NOTE:  Color coded legend is located top right of the window. 
 
Step 7:  Fill in the information.  As you tab to each field, explanations of the field 
and alternate contents will be displayed in the lower right portion of the window.  
Directly below this will either be the range of valid values or examples of valid 
values.  These values may be entered manually or in some cases can be 
selected from the yellow Pull-down menu. 
 
Step 8:  To add duplicate lines such as GNDOP or KSALUTE: 

(a)  Click on the line title. A menu will appear. 
(b)  Select Repeat. 
(c)  Some lines have a button with ‘//’ at the end.  Left Click (L/C) 
on this button to create a duplicate line.  

Note: If user duplicates a mandatory line, it cannot be deleted from the message 
mask. 
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Step 9:  Under Message, select Compress.  The message will lose most of the lines that are left 
blank, will put in a dash for fields that are left blank, and a looping arrow for blank lines.  If a line 
has no information and does not drop out, delete it by : 

(a)  Click on the line title.  A menu will appear. 
(b)  Select Delete.  The line will be deleted from the message. 

Step 10:  Select the ‘Header’ tab, and fill in the information.  
(a)  L/C on ‘Add’ from "Destination Information" 
(b)  Select the addresses or address groups desired, or filter 
criteria,  then Done. (Destination Address will AutoFill Header 
window) 
(c)  Select an addressee action (to, info) by L/C on ‘Addressee 
Action’.  ‘To’ is the default. 

     (d)  Select precedence for Action and Info. 
 
 
 
Conduct Interactive Message Parsing:  Back to Top 
 
Step 1:  When you notice that the "SIT-IN"queue of the FI is increasing, press the 
"In-Queue" button. 
 
Step 2:  Select "Interactive Message Parsing".  The messages that failed 
automatic parsing will be displayed as "Error" messages. Also, all S302 Freetext 
and other non-parsable messages will be displayed as text messages.   

 
NOTE:  Text messages can be accessed directly in Text Message Read File, which is 

the next option below Interactive Message Parsing. 
 

Step 3:  Select the desired message. 
 
Step 4:  Under "File", select "Edit" or double click on the desired message.  Most 
values that caused the error will be highlighted and explained in the bottom of the 
window.  
 
Step 5:  Edit the error and select Check. 
 
Step 6:  Edit the values so that they can be parsed and press "Check" and 
Release.  
 
Step 7:  To skip an error, select Next Error. 
 
Step 8:  If the problem appears to be a recurring problem with improperly used 
USMTF messages, send a message to the originator  informing him to correctly 
fill out the message form. 
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Access Message Journal Review:   Back to Top 
 
Step 1: Select "Common Functions" from the top menu. 
 
Step 2: Select "Message Journal Review" 
 
Step 3: Under "Options" select "Filters". 
 
Step 4: Set the criteria for the type of messages you want to  
receive.  The following parameters can be specified: 

a. Start and Stop message DTG 
b. Message type 
c. Range within the journal 
d. A message qualifier 
e. A message qualifier serial number 
f. The message originator 
g. The message section number 
h. Number of message to query 
i. The short form of the message classification 
j. Message routing (inbound, outbound, or both) 
k. Mode of traffic (exercise or optional) 
l. A marker for exercise nickname or operation codeword 
m. The message precedence 

           Hit "Apply" then "Ok" to lock in choices or Click on the  
           "Default" if you want to receive all the messages. 
 
 Step 5: Click on the question mark located in the top left-hand  
            Corner of the window.  (All messages appear---up to 200 at a time)      
            
Step 6: Scroll down to the message you want to view.  Double click 
           on the message to open it.  
 
NOTE:  ULP SDR (Upper Layer Protocol Software Delivery Report) will not 
always guarantee delivery of a message but is a good indications.  Only 
messages sent via ULP will receive an SDR upon successful delivery   
 
Step 7: Select "File", then "Exit" to return to the previous screen. 
 
 
Targeting terminology, coordinating  
with the FSE and RWS queues and menus:   Back to Top 
 
1. Plain Language Address (PLA):  This is the communications address 

assigned to a unit on the battlefield.  You must obtain the proper PLA(s) for 
the recipient(s) of the TIDAT (Target Intelligence) message.  This will be used 
to establish the TIDAT_Group address under COMMs, Group Maintenance. 
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2. The Assigned Target Number Block: This is the block of numbers assigned by 

the Fire Support Element (FSE) to serialize the target nominations it receives.  
It is a method for tracking where a target nomination originates; each unit 
authorized to nominate targets has an assigned block.  A target number is a 
seven-character code composed of three letters and four numbers.  There are 
other types available but this is the most commonly used by artillery forces.  
For example, AA0001-AA0750 belongs to forward observer 1, AA0751-
AA1500 belongs to forward observer 2, AA1501-AA2000 is for your RWS, 
AB0001-AB0500 is COLT 1, etc. 

 
 

3. High Value Target List (HVTL): Assets that the enemy commander requires 
for the successful completion of his mission.  The HVTL is usually created by 
the S2/G2 after coordination with the FSE and S3/G3. 

 
4. High Payoff Target List (HPTL): HPTs that must be acquired and successfully 

attacked for the success of the friendly commander’s mission.  Basically, this 
means what has to be acquired and attacked to save us and stop the enemy.  
This list is normally developed by the FSE or targeting team with input from 
the S2/G2/ACE and passed to all concerned sections.  There is a doctrinal 
way to display this list that includes priority, category, and description but 
most units have their own method that combines this information with the 
AGM (Attack Guidance Matrix) and other pertinent data.  This data MUST be 
available to the 2 shop and RWS analysts to properly support the unit’s 
targeting mission. 

 
5. Attack Guidance Matrix (AGM):  This shows how targets should be attacked.  

Doctrinally it should include the target category, HPTs for each category, 
when and how the target is to be attacked and any restrictions that exist.  
Units usually include this data in the HPT and include other data such as TLE, 
minimum target size, activity, target decay time, when to engage, desired 
target effect, and type of firing unit or equipment.  

 
 

6. The Target Selection Standards (TSS):  These are the parameters or 
requirements to identify an attackable target. This is built and stored in 
AFATDS but not passed electronically to ASAS since it really is meant for use 
only by artillery sources.  It  may be passed by the FSE to the G-2/S-2 via 
hardcopy.  It lists sources of targets and known and suspected targets for 
each.  It can also contain location, size and time requirements or other data.   

 
7. Target Management Matrix (TMM):  This is contained in AFATDS and is used 

to determine the order of attack of targets.  It can contain some data to 
determine the attack ability of a target and is often used in conjunction with 
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the AGM by AFATDS.  This is not electronically passed to ASAS since it is 
meant for AFATDS decision making. 

 
8. Target Location Error (TLE):  This is a primary factor used by artillery units for 

determining whether to fire on a target or not.  Basically, if we say that the 
location is at point A and assign a 50-meter TLE, we are saying that the 
actual location can be anywhere within a 50-meter radius from that 
designated point.  If a nominated target exceeds the allowable TLE, it will not 
be a valid target for fire.  ASAS refers to this as the Target Report Accuracy.  
You must obtain this TLE for each target from the arty folks. 

 
9. Target Category: There are thirteen categories used by artillery forces.  They 

are Command, Control and Communications (C3); Fire Support (FS); 
Maneuver (MAN); Air Defense Artillery (ADA); Engineer (ENGR); 
Reconnaissance, Surveillance, and Target Acquisition (RSTA) or 
Reconnaissance, Intelligence, Surveillance, and Target Acquisition (RISTA); 
Radio Electronic Combat (REC); Nuclear/Chemical (N/CH); Petroleum, Oil, 
and Lubricants (POL); Ammunition (AMMO); Maintenance (MAINT); Lift 
(LIFT); and Lines Of Communication (LOC).  These break down to target sub-
types for a total of 95 available targets for nomination to AFATDS.   

 
10. Target Type:  This is how ASAS reports a target; it is a 2 to 6 character field 

to identify a specific type of target  (not a specific piece of equipment, 
designated unit, etc.).  We have thousands that are possible with many not 
having a clear-cut equation to the AFATDS target category and sub-type.  
When you coordinate with the FSE, you must determine what the AFATDS is 
wanting and what target types we will use to report the targets.  There can be 
several choices available but an agreed upon choice should be used.  An 
example is the surface to air missile, it can be either SAM or ADAMSL.  Both 
arrive at AFATDS as the same type but in the TIDAT itself, SAM might be 
used for mobile launchers and ADAMSL for fixed site missiles or SAM for 
hand held missiles and ADAMSL for mobile launchers.  This could allow the 
AFATDS to review the message when the target is being processed to 
determine what exactly was the target.  This is a general guideline that has 
been tested and verified.  However, due to the order of battle,  it may be 
necessary for you to create your own working aids to translate RWS target 
type codes to AFATDS target codes for some exercises or field problems. 
This will ensure that per the guidance you are given, what you believe to be 
important enough to target will be accurate at the FSE.  Other examples are: 
S-60 = AAAL, T-80 = MDMTK, BM-22 = LCHRKT.  These equations must be 
coordinated with the FSE to avoid confusion.  Also, the equations can be 
good for several exercises but due to the targets used for another exercise, 
more work may be required. 

 
11. Target Decay Time:  This tells how old is the data.  This is crucial for 

targeting.  The time is usually noted in the HPT; do not nominate a target that 
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exceeds the time unless it is a critical target and is barely beyond the decay 
time.   Obtain this information from the arty folks. 

 
12. Movement Data:  Is the target moving or stationary is another critical bit of 

data for artillery assessment. 
 

13. Ammunition Fire Unit – Mission Fired Report (AFU.MFR)/C241:  Used to 
report end of mission with data for rounds and fuses used; sent from firing 
unit to controlling unit(s).  When sent to ASAS, it is used as confirmation of a 
good nominated target. 

 
14. Artillery Target Intelligence – Artillery Target Report (ATI.ATR)/C281:  Used to 

exchange data among artillery units.  When sent to ASAS, it is used as denial 
of a nominated target. 

 
15. Artillery Target Intelligence –Intelligence Electronic-Warfare  Target 

Coordination (ATI.IEWTC)/S308:  Used by  AFATDS to request a decision 
from ASAS on an IEW related target. 

 
16. Artillery Target Intelligence –Target Criteria (ATI.TCRIT)/D281:  Used by 

AFATDS to identify up to nine targets for ASAS to nominate when 
encountered. 

 
17. Target Intelligence Data (TIDAT)/S305:  Used by ASAS to nominate a target 

to AFATDS. 
 
18. Target Procedures:  The ASAS analyst must perform certain procedures to 

accomplish the targeting mission and must coordinate with the FSE or FAIO 
(Field Artillery Intelligence Officer) or other artillery interface to properly 
perform these procedures.  These include establishing the TIDAT address 
group, listing the assigned target number block, developing the target 
definitions, creating database queries or alarm criteria for possible target 
identification, nominating targets to AFATDS, verifying nominated target 
status, and coordinating IEW related target procedures. 

 
19. SIT In Queue – Data Criteria Alerts:  All data that meets active criteria will 

display here no matter whether Interrupt, Plot or Automatic Message 
Generation was selected. 

 
20. SIT In Queue – Message Based Alerts:  All data that meets artillery related 

SRI Maintenance Criteria (keyword search).  This can only be used for 
notification purposes; there is no interactive software link here. 

 
21. SIT In Queue – Interactive Message Parsing: Incorrect ATI.IEWTC and 

ATI.TCRIT messages received from AFATDS display here.  The analyst must 
review and correct the message then release it for system processing, if 
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possible.  If not possible, correction and retransmittal must be requested from 
AFATDS. 

 
22. SIT In Queue – Text Message Read File: AFU.MFR and ATI.ATR received 

from AFATDS in response to your issued TIDAT messages.  This is a read 
file only and is not interactive with other processes. 

 
23. SIT In Queue – Immediate Targets:  This queue is normally populated from 

items meeting data alert criteria but one or more of the three pre-requisites is 
not performed (definitions, parameters and address). 

 
24. SIT In Queue – Renominated Targets: This queue is normally populated from 

items meeting data alert criteria that have already been nominated but one or 
more of the three pre-requisites is not performed. 

 
25. SIT Process Queue – Development Targets:  This queue is for items that you 

don’t wish to nominate currently but later you might when more data is 
available. 

 
26. SIT Target Tools – Target Definitions:  This is where you build the default 

data for the mandatory TIDAT fields that might not exist in the database 
record. 

 
27. SIT Target Tools – Target Parameters:  This is where you establish the target 

number block to be used in the TIDATs. 
 

28. SIT Target Tools – High Payoff Target:  This is where you develop the HPT 
list and can forward it to the AGM. 

 
29. SIT Target Tools – High Value Target: This is where you develop the HVT list 

and can forward it to the HPT. 
 

30. SIT Target Tools – Attack Guidance Matrix: This is where you develop the 
AGM list. 

 
31. SIT Target Tools – Target Criteria Processing:  This is the same as the SIT In 

Queue – Data Criteria Alerts presented earlier. 
 

32. SIT Target Tools – Target Coordination:  This is where a delayed ATI.IEWTC 
message resides until you wish to process the data. 

 
33. SIT Target Tools – Nomination History:  This is where all previously  
      nominated targets reside for review and possible re-nomination action. 
 
 
Maintain the High Value Target (HVT) List:  Back to Top 
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Step 1:  From the SIT FI, select “Target Tools”. 
 
Step 2:  From the Target Tools window, select “High Value Target” (HVT). 
 
Step 3:  From the file menu or the bottom of the window, select “New” The New 
HVT List Item window opens. 
 
Step 4:  Enter New HVT List Name in dialog and click “OK”.  The New dialog 
closes; the name is added to the TGT-HVT List window. 
 
Step 5:  The TGT - New HVT List Item window opens. Select “New”. 
 
Step 6:  Select a Category in the Categories field and click the “Select” arrow.   
There are thirteen categories used by artillery forces. 
 

1. Command, Control and Communications (C3). 
2. Fire Support (FS). 
3. Maneuver (MAN). 
4. Air Defense Artillery (ADA). 
5. Engineer (ENGR). 
6. Reconnaissance, Surveillance, and Target Acquisition (RSTA) . 
7. Radio Electronic Combat (REC). 
8. Nuclear/Chemical (N/CH). 
9. Petroleum, Oil, and Lubricants (POL). 
10. Ammunition (AMMO). 
11. Maintenance (MAINT). 
12. Lift (LIFT). 
13. Lines Of Communication (LOC).   

These break down to target sub-types for a total of 95 available targets for 
AFATDS.  Once you have selected a category, it is placed in the Category 
field. The Target Types field is populated with the target types for the 
selected category. 

Step 7:  Enter the Priority for the selected category in the Priority field. The 
default is 1 (one) and the maximum is 99. (NOTE:  This priority is for in-house 
management of targets by the RWS.) 
 
Step 8:  Select the target type in the Target Types field and click the “Add” arrow.  
The selected target types are moved from the Target Types field to the Selected 
Target Types field. 
 
Step 9: Select “Apply”. 
 
Step 10:  Once you have entered everything into the HVT, select “Done”. 
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Save an HVT List as a new name:   Back to Top 
 
Step 1:  Select HVT List to be copied. 
 
Step 2:  From the Selected menu , select “Save As”. (The Save As Dialog 
opens). 
 
Step 3:  Enter a new HVT List Name on the Save As dialog and click “OK”.  The 
dialog closes and a New HVT List is created. 

 
Modifying an HVT List:     Back to Top 

 
Step 1: Select HVT List for update. 
 
Step 2:  Click on the name of an HVT and select “Open”. 
 
Step 3:  Highlight the category to be modified and select open.  Utilize the 

procedures we discussed earlier to modify the categories or targets. 
 
Step 4:  Select “Apply” and then “Done”. 
 
 
Maintain the High Payoff Target (HPT) List:  Back to Top 
 
Step 1:  From the SIT FI, select “Target Tools”. 
 
Step 2:  Click on “HPT”.   
 
Step 3:  Highlight a HPT list and click on Open.  
 
Step 4:  Highlight a category and click on Open. 
 
Step 5:  Select the target type in the Target Types field and click the “Add” arrow.  
The selected target types are moved from the Target Types field to the Selected 
Target Types field. 
 
Step 6:  Highlight a selected target type. 
 
Step 7:  The differences in the HVT and HPT windows are the following: 
1. IEW buttons.  Select YES or No (Choice depends upon whether the target 

type is to be engaged with IEW assets or whether coordination with IEW unit 
is required prior to attack. 

2. Enter a priority 
3. When Displays when the target type should be engaged. Values are I-

Immediate, P-Planned, or A-As acquired. 
 



 84

Step 8:  Select  “Copy to AGM”.  Give your new requirement a name. This name 
will be added to the AGM and will be visible once you select the AGM function. 
 
 
Create an Attack Guidance Matrix (AGM)   Back to Top 
 
Step 1:  Under the SIT FI, select “Target Tools”. 
 
Step 2:  Select “AGM”. 
 
Step 3:  Highlight one of the AGM lists and click “Open”.  
 
Step 4:  Highlight one of the categories and click “Open”.  
 
Step 5:  Highlight one of the items in the “Selected Target Types: box.   
 
Step 6:  Look at the box labeled ‘When’.  This box contains some extra options 
for the analysts but is only available when a “Selected Target Type” has been 
highlighted. 
 

a. When ( I-Immediate, P-Planned, and A-As acquired) 
b. How (Available options are neutralize, suppress, destroy, DNE (Do Not 

Engage), and specified %). 
c. Attack with EW (yes or no). 
d. Coordination (None, G2, G3) 
e. Restrictions. (freetext entry) 

 
Step 7:  Review your choices. Ensure that they are correct. Select “Apply”, then 
“Done”. 
 
 
Create a TIDAT Address Group:    Back to Top 
 
Step 1:  Select “Group Maintenance” function from the COM FI. 
 
Step 2:  Select TIDAT_GROUP entry. 
 
Step 3:  Select desired entry(s) in Possible Destination.  Initial list of addressees 
will only be AFATDS (fs#####).  
Must make change in Address Maintenance option under COM FI for each 
address resume to receive the TIDAT.   
 
Step 4:  Click right arrow located between Possible Destination and Group 
Members 
 
Step 5:  Repeat steps 3 & 4 for each desired address entry. 
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Step 6:  Click Apply button. 
 
Step 7:  Click Done button. 
 
 
Create TIDAT Default Data:    Back to Top 
 
Step 1:  Select “Target Tools” function from SIT FI. 
 
Step 2:  Select “Target Parameters”  
 
Step 3:  Use Tab key to move from entry to entry.  Some entries are activation 
buttons while others are selection buttons or fill in fields.  Usually you will use the 
default data and only work in the Target Number Block portion. 
 
Step 4: Message Information: 

1. Message Precedence:  The default precedence is Immediate, but clicking 
the down arrow displays choices of Flash, Immediate, Priority, and 
Routine.   You must coordinate with the FAIO, FSO, etc. to see if a 
change is needed. 

2. Target Nomination Message: Default is TIDAT (Target Intelligence Data).  
The other message type is ATI:CDR. This message type is not available 
on the RWS right now. 

3. Target Identifier for Message:  This tells the system what type of target 
number to place in the outgoing message.  The ABCA number is the 
default (American British Canadian Australian).  The other choice is BE 
(Basic Encyclopedia) Number with Suffix, but this is usually only used if 
working joint service with the Air Force.  BE numbers are used with targets 
derived from imagery. 

 
Step 5: Target Information:  

1. Target Identifier for Display:  This tells the system what kind of target 
number to use if the option to display the number on the map by the target 
icon is activated.  Default is ABCA.  Other choices are BE Number, BE 
Number with Suffix, Entity Code, PIN (Permanent Installation Number – 
ELINT targets) Number, and Theater Target Number.   

2. Target Location Conflict Distance (KM):  This is used to compare the final 
nomination location to the database record location.  If the distance 
exceeds this set number, you should receive a notification message.  The 
Default is 1.0 but you can type in what you want if you decide to change 
this. 

3. Delta Distance for Renomination (KM):  This is used to compare the 
current nomination location to a previously nominated location.  Distance 
must meet or exceed to make renomination viable.  The Default is 1.0 but 
you can type in what you want if you decide to change this. 
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Step 6: Target Number Block: This is a multi-part area.  The allocation  of the 
Target Number Block is mandated by AFATDS. 

1. Starting Number:  Type in 6 character target number that is the first in the 
assigned block. 

2. Ending Number: Type in the 6 character target number that is the last in 
the assigned block. 

3. Used:  This starts at 0% but after the numbers are entered and target 
nominations are generated, the system will automatically calculate what 
percentage of the total block has been used. 
 
If no numbers have been put in here, when you try the first target 
nomination, you will receive a notification message that no target numbers 
are available. 
 
Cancel action on a TIDAT form will list that target number as being used 
and will go to the next number when the next TIDAT is initiated. 
 
When the last number has been used and you attempt the next target 
nomination, you will receive a notification message that no target numbers 
are available.  You must coordinate with the AFATDS to issue a new set 
of targeting blocks.  

Step 7:  Target Setting:  This is supposed to ensure that the same target is not 
nominated more than once.  The default is Automatic Delete of Suspected 
Duplicates.  Clicking on the button raises the button and discontinues the auto 
delete action. 
 
Step 8:  Done button:  This tells the system to save your inputs or changes and 
exit the function.  This saves the Target Number Block data to the 
TGT_NUMBER_TABLE and all other data to the analyst portion of the 
TGT_PARAMETERS_TABLE. 
 
Step 9:  Restore Defaults button:  Except for the Target Number Block entries, 
this resets all fields back to the default data of the TGT_PARAMETERS_TABLE. 
 
Step 10: Cancel button:  This exits the form without saving any analyst action. 
 
 
TGT_ENTITY_TRANS table:    Back to Top 
 
Step 1:  Select “Table Maintenance Tools” from the DBM FI. 
 
Step 2:  Select “Table Maintenance”. 
 
Step 3: Select “Tables”… option under the Query pull down menu. 
 



 87

Step 4: Scroll to the TGT_ENTITY_TRANS entry. 
 
Step 5: Double click the entry or select the entry then click the right arrow button. 
 
Step 6: Click the “OK” button. 
 
Step 7: Select “Execute Query” option under Query pull down menu. 

 
 IMPORTANT NOTE:  THIS TABLE SHOULD NOT BE MODIFIED BY THE 
BASIC OPERATOR.  IF MODIFICATION IS NEEDED, A SUPERVISOR 
SHOULD MAKE THE CHANGES DUE TO THE CRITICALITY OF IT 
DAMAGING THE COMMUNICATIONS BETWEEN THE RWS AND AFATDS 
 
 
Target Definition function and  
performing the necessary creation,  
modification, and deletion actions:   Back to Top 
 
 
Step 1:  Select “Target Tools” option from SIT FI. 
 
Step 2: Select “Target Definitions”. 
 
Step 3: Create a new entry by either clicking the “New” button or select “New” 
from the File pull down menu. 
Step 4:  Fill in form – mandatory fields have vertical bar to the left of the field.  You can 
Tab from field to field.  
 
1. Entity Code: Used to match a nominated database record with the 

appropriate existing target definition.  Click on down arrow to display list of 
entries to select desired entry; most are three characters but there are some 
four character entries and at one time we even had a few with five.  This 
selection modifies the Target Type field.  This is not an all inclusive list; there 
can be database records that have an entity code that isn’t here. 

2. Target Type: The target type is linked to the entity code in the 
TGT_ENTITY_TRANS table.  This field will display the appropriate data from 
your entity code selection.  You can click on the field and it will display the 
only choice assigned to the selected entity code. Select EOAG. 

3. Circular button/Radius field:  This is the default.  It identifies the target 
location as being at a specific point with a designated radius in meters.  This 
is the easiest way to pass the location to AFATDS.  Place cursor in Radius 
(m): field and type in the desired meters radius. 

4. Rectangular button/Length-Width-Attitude fields:  This is rarely used because 
it takes more work.  The analyst requires a target length and width in meters 
and the attitude (orientation) in degrees. 

5. Size:  This is either the echelon of the target or a general indicator or physical 
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deployment size.  The default is SM (Small); this means the target covers 60 
meters or less.  Other entries are MED (Medium = 60-200 meters), LGE 
(Large = over 200 meters), BN (Battalion), BTRY (Battery), BDE (Brigade), 
CO (Company), DIV (Division), PLT (Platoon), RGT (Regiment), SQD 
(Squad), and SECT (Section).  This data is pulled from the Size field in the 
database record, not the echelon field. 

 
6. Number of Target Elements:  This is the quantity field from the database 

record for the TIDAT. 
7. Target Report Accuracy:  This equates to the TLE we talked about earlier.  

Make sure that you do not exceed the maximum allowable TLE from the 
HPT/AGM/TMM/TSS used by AFATDS 

Step 5:  Done button:  This saves the data and exits back to the directory 
if all data is complete and accurate.  Missing or inaccurate data displays 
the Target Definitions – Entry Errors form to identify the errors.  You 
correct the errors then click the Done button again. 
Step 6: Create three other entries using the same procedures. Use EOAH 
for medium man pack mortar, EOBL for hvy twd mortar and EOBQ for vy 
hvy twd mortar. 
 
 

Modifying Target Definitions:    Back to Top 
 
Step 1: Select desired entry. Select EOAG*.  If not present, chose something 
else. 
Step 2: Click Open button or select Open … option under the Selected pull down 
menu. 
 
Step 3:  Make modifications.  Except for the Entity Code field and related Target 
Type, you can modify any field. Change Size or TLE. 
 
Step 4: Click the Done button to save the data and exit the form. 

 
Deleting Target Definitions:    Back to Top 
 
Step 1:  Select desired entry. 
 
Step 2:  Click Delete button or select Delete option under Selected pull down 
menu. 
 
Step 3:  Click Yes button.  The directory automatically updates – there is no way 
to undo this action so be sure you really want to delete an entry(s) when you click 
the Yes button. 

 
Printing Target Definitions:    Back to Top 
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Step 1: Select Print List option under the File pull down menu. 
 
Step 2:  Click header/trailer Off button. 
 
Step 3:  Optional – click Select Printer button, select desired entry, then click 
Done button. 
 
Step 4:  Click Print button. 
This can be helpful as an SOP or TTP item.  If you print this and have a new 
software load or your disks go out, you have the data available to rebuild with the 
least amount of hassle. 
 
 
Create, Activate and maintain Data 
Criteria Sets:       Back to Top 
 
Step 1:  Select the “Alert Criteria Development” from the SIT FI.  
 
Step 2:  Select the FI these criteria will pertain to.  The FI’s available are the ICM 
and SIT FI.  For Targeting or Situation Development, you will select SIT.  When 
the user sets the alarm criteria under the ICM FI, they will not be able to set the 
Target Priority or be able to automatically generate messages when the criteria 
alarms are set. 
 
Step 3:  Select “New Set” from the File menu.  This brings up a " SIT New Set" 
form. 
 
Step 4:  Enter a unique name for the set in the “Set Name” field. 
 
Step 5:  Set the activation status to “Active” or “Inactive”.  If you select “Inactive”, 
you can come back and activate the set later. 
 
Step 6:  Enter the map name in the “Alert Map Window” field.  The name of the 
map will appear in all capital letters.  This designates the map window in which 
the alerts will plot if you select “Plot” option in individual records.   This was done 
so that if you want you can separate the map for alert plotting from your Sit map 
which might be running a shared overlay or graphic INTSUM, or anything you 
might not want stray map symbols popping up.  If the map you have designated 
for the Criteria Set is up, it will immediately plot to that map.  If it is not, the 
software will first activate that named map and then plot the map symbol. 
 
Step 7:  Select the “Done” button and a  “New record” window will display.     
Task 
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Data Criteria Record:     Back to Top 
 
Step 1:  On the “SIT New Record” window, enter a unique name for the record.  
This name should be indicative of what you are looking for, like T72 or Mech 
BDE, because it will appear on the interrupt window if you select that action.  
Also it will help you manage the records without continually opening them to see 
what they are about. 
 
Step 2:  Enter a record priority.  These run from 1 – 200, 200 being the default.  
This is the priority of plotting and interrupting the RWS in the event of multiple 
data hits at once.  The priority of each record should be a matter of unit SOP, 
where your unit may designate its PIRs as the highest priorities. 
 
Step 3:  Enter a target priority.  The range for Target Priority is 1A to 4Z.  Usually 
you will base your target priorities off of the HVT, HPT, and AGM. This 
numbering system is dictated by AFATDS and is for their processing of TIDATs. 
 
Step 4:  Select Target Criteria (TCRIT) if the alert is in response to TCRIT 
guidance.  
 
Step 5:  Select an analysis context, either “Pre” for before the information is 
parsed into the ASCDB, or “post” for afterward.  For the purpose of the RWS, 
where very little automatic correlation is conducted before data is placed in the 
ASCDB, all criteria should be “Pre”.  
 
Step 6:  Select “Active” for the activation status.  You can change the activation 
status of any record, and different records within the same set can have different 
activation statues.  Again, set activation is independent of record activation, but a 
set must be active for its records to be effectively active.  Active records in active 
sets will generate alerts when their criteria are satisfied. 
 
Step 7:  Alert types are used during multi-node operations – they enable you to 
designate a workstation for a particular type of alert so that the interrupts and 
plots go to a single workstation instead of all workstations that are in the node.   
Identifies User that is registered to process the alerts that are generated from this 
Criteria Record, this can be user named alert type (i.e. USER01, TANKS, etc.). 
 
Step 8:  Select the Alert Action.  Either “Interrupt”, which will place a dialog box in 
your workspace when the alert is tripped, and/or “Plot”, which will automatically 
plot the information to a map.  If you do not select one of these options, then you 
remain alerted to incoming alerts by monitoring the SIT in-queue.  It will increase 
as alerts are tripped.  Be very selective in using this option.  Auto plotting will 
slow the system down.   The symbols will display on yellow.  The symbol will 
clear off the map when the alert interrupt is dismissed. 
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If you select “Interrupt”, a dialog window will display when the alert is 
tripped.  The dialog box lists the criteria set and record names, the entity 
type which is being captured in the alert, and the location and time at 
which the entity was reported.  In the dialog box you can acknowledge the 
alert, plot the information to a map, and review the message, which 
tripped the alert. 
 

1. The acknowledge button clears the interrupt dialog box from the screen. You 
would use it if you see from the information contained in the dialog box that 
you are no longer interested in the alert, or is lower in importance, you will go 
back to the Data Alert Queue later to finish checking it out. 

2. The plot button immediately plots the entity to the map.  Once you have the 
symbol on the map you can use Entity operations to do any other functions 
such as sending out a SALUTE, TACREP, or Target Nomination message. 

3. Reviewing the message is sometimes the first step you would want to do 
before deciding on any further actions because the message originator or any 
narrative or remarks lines might give you additional information that you 
would not get just by plotting a symbol to the map. 

 
If you select “Plot”, a map window will open and the entity will plot in 
“yellow”.  Whatever virtual workspace is currently open is where the map 
window will open.  

 
Step 9:  If you want the alert to automatically generate an outbound message, 
select on or both of the following options under  “Generate message Options”.  
The messages you can select are:   

 
1. Salute - Automatically creates a SALUTE. 
2. Target Nom – Automatically creates a TIDAT. 
3. Threat Alert – Automatically creates a TACREP. 

 
Step 10:  Once you select one of these options, “Display Generated Message” is 
automatically highlighted.  Currently this portion of the functionality only pertains 
to TIDAT.  If you do not select this option, then TIDATs will go out of the system 
without the analyst seeing the message.  If this is selected, TIDATs will display 
on the monitor automatically when they are created for the analyst to review 
them.   TACREPs and SALUTEs created automatically by Criteria alerts will go to 
the SIT out-queue for review and transmission regardless of this selection.  The 
Target Definitions button will be Automatically highlighted when TIDAT is 
selected.  Open the Target Definitions window to match Entity codes to target 
types.  The Entity code you specify in Criteria Development must map to a valid 
AFATDS target type in order for a target nomination to be meaningful.  
 
Step 11:  Select an Attribute Group.  These are the areas where the criteria for 
triggering the alert are set.  You must enter some value in the “General” area.  All 
other areas are related to values specified in the “General” area, but not to each 
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other.  
1. “General” attribute allows the user to select criteria by Location (NAI, TAI, AOI 

or DP), Time, Message Type, Message Originator, Message Precedence, 
and Producer Designer Digraph. 

2. “Unit” attribute define Unit specific information for this Criteria Record by 
Allegiance, Entity Code, Activity Code, Unit Number, Entity Type, Org. Type, 
Functional Role, Parent Unit #, Parent Org Type, Parent Echelon, Direction, 
Speed Range, and Echelon Range. 

3. “Equipment” attribute defines Equipment specific information for this Criteria 
Record by Allegiance, Entity Code, Activity Code, Equipment Name, Entity 
Type, Quantity Range, Direction, Speed Range and Associated Weapon 
Type. 

4. “Facility” attribute defines Facility specific information for this Criteria Record 
by Allegiance, Country Code, Entity Code, Activity Code, Entity Type, Facility 
Name, Target TTN, BE/Suffix number, and Installation PIN. 

5. “Radar” attribute defines Radar specific information for this Criteria Record by 
Allegiance, Entity Code, Entity Type, ELNOT (ELINT Notation), Associated 
Weapon Type, and Frequency Range. 

6. “Radio” attribute defines Radio specific information for this Criteria Record by 
Allegiance, Entity Code, and Entity Type. 

 
Step 12:  Fill in the criteria of each group as Necessary.  Try not to make your 
search too broad or too narrow.  The entity code and entity type should not be in 
conflict.   Within each section (General, Unit, Equipment, and facility) the criteria 
are “AND” instead of “OR”.  That is, all criteria within that section must be 
satisfied for the record to cause an alert.  The more criteria you add for a record, 
the harder it is to trip.  Since you can create up to 200 records for each set, you 
may wish to cut large records into smaller ones. 
 
Step 13:  Review the criteria in the scrollable window for correctness. 
 
Step 14:  Press “Done”.  This enters the record into the database and closes the 
record form, returning you to the main Alert criteria window.  You will see the 
record you just completed, whether or not it is active, and any actions you 
selected, such as Interrupts, Plot, etc. from this panel you can change the 
activation state of the record, or open the record.  Refresh will update the window 
with any new information since the window was opened.  For edit, deletion or 
duplication.  Duplication is handy if you want to use your first record as the 
starting point for other records, so you don’t have to repeat the geographic 
coordinates, or any other criteria you might have established in the General 
section.   Selecting Duplicate opens the record and allows you to make any 
changes you need to differentiate this new record.  You must give it another 
name before closing out this new record. 
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Data Alert Processing Queue:      Back to Top 
 
We are now going to go to the Data Alert processing Queue so you can see how 
to manage alerts once incoming message traffic has activated them.   

 
Step 1:  Go to the upper left of your ASAS Banner where you see the Functional 
Identities with queue counts. 
 
Step 2:  Select the “In” button under the “SIT” FI.  This will open a box with the 
different SIT queues. 
 
Step 3:  Select Data Criteria Alerts so that the queue opens up.  From here you 
can manage all alerts which have entered your system.  The queue shows 
information about the entity which tripped the alert, the record name, the priority, 
if the source of the alert was an EDC, and if a TACREP or TIDAT was generated 
by the alert.   
 
Step 4:  Selecting any of the alerts in the queue allows you to plot the entity, 
generate a TACREP or TIDAT, or simply acknowledge the alert.  Acknowledging 
the alert decrements to queue count on the ASAS banner and removes the alert 
for the Unacknowledged View of the queue.  
 
Step 5:  You can manage your view of the Acknowledged/Unacknowledged by 
using the View menu at the top of the Queue window.  It is best to keep the Data 
Alert Processing Queue cleaned up by acknowledging the alerts which you do 
not intend to take any further action on.  This ensures that the queue only 
contains those alerts that are still important and you are still working off with 
action of some type.  Keep in mind that if you are just “Acknowledging” them to 
get rid of them, that you should go back to the criteria Record and turn it off or 
update it. 
 
 
Create and maintain Message Criteria Sets:  Back to Top 
 
Step 1:  “Select “Message Criteria Development” from the SIT FI. 
 
Step 2:  Under "Options", select "SRI Maintenance". 
 
Step 3:  Under "File", select "Create". 
 
Step 4:  Enter a unique name under “Descriptor”. 
 
Step 5:  Select the activation type:   
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1. Single - one use.  This is useful if you are looking for the first report of 
something. 

2. Repeatable - can be tripped multiple times. This is useful for requirements 
that require continual updating of information. 

 
Step 6: Enter activation start and stop DTG's, if needed. 
 
Step 7:  Under SRI Notification Info select a delivery method: 
1. File 
2. FID 
3. ReXmit - retransmit to another user. 
 
Step 8:  Under SRI Notification Info select a destination: 
1. File path name.  If you use this option, it is suggested you use your personal files directory. 
2. FI – Sends it to the in-queue of the controlling FI.  This is the most commonly used 

destination. A different Functional Identity can be selected. 
3. Address of a distant user or address group. 
 
Step 9:  Under Message Criteria enter a message type or originator, if desired. 
(This is not require, but if entries are made it will narrow the keyword search by 
that message type or originator.  
 
Step 10:  Under Keywords Match enter "Keywords" for the search.  They must be 
in all capital letters. 
 
Step 11:  Highlight a keyword. Press the  "Edit Alias" button.  This allows the 
analyst to have multiple spellings of the same word, as well as variations, i.e. 
tank, tk, T-72. 
 
Step 12:  Press "Normalize".  All aliases for the keyword will display. 
 
Step 13:  Highlight the desired aliases and select "Save". The message on the 
right side of the window will tell the analyst how many alias have been selected 
(for the record) and how many options are left.  
 
Step 14:  Push "Exit". 
 
Step 15:  Under "File", select "Save". 
 
Step 16:  Under “File”, select “Exit”. 
 
Step 17:  From the “SRI Maintenance” window, select “Options” then “Activate”.  
The message criteria set is now active 
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Produce Targeting Intelligence Data  
(TIDAT) message:   Back to Top 
 
Step 1: Optional – Review incoming data message. 
     a. Click Retrieve Msg button on SIT – ALERT INTERRUPT window. 
     b. Read message. 
     c. Determine desired course of action. 
 
Step 2: Click Plot button on SIT – ALERT INTERRUPT window. 
 
Step 3:  Review map display. 
 
Step 4:  Determine desired course of action. 
1. Disregard target – Click Cancel button on SIT – ALERT INTERRUPT window.  

This removes the entity from the map but it remains in Alarm Processing. 
2. Nominate target.  This function can be accomplished from either the icon 

plotted to your map or from the alert directory. 
 
Step 5:  Map icon procedures: 
1. Select icon on map. 
2. Click RTB to bring up Entity Operations. 
3. Select desired entity in Entity Operations window. 
4. Select “Target Nom” button. 
5. Go to Step 7. 
 
Step 6:  Alert Directory procedures: 
1. Click Cancel button on SIT – ALERT INTERRUPT window. 
2. Click on SIT FI In queue counter. 
3. Click on Data Alert Processing entry. 
4. Select desired entry. 
5. Select “Generate” from the Selected pull down. 
6. Select “Target Nomination”.  
 
Step 7:  Fill in form if fields are not filled by Target Definitions data or modify 
fields as desired. 
1. Mandatory fields identified by vertical bar to the left of the field. 
2. Message Priority:  FLASH is default; change if AFATDS or artillery folks 

desire a change. 
3. Target ID: Filled from Target Parameters; the next assigned ABCA  number. 
4. Target Type:  Taken from database record if available or from entry in Target 

Definition.  Blank if nothing in Target Definition matches the entity code. 
5. Activity Day-Time:  Database record time for time down, time off station, time 

lost, etc. 
6. Equipment Category:  Optional field even though the default MISC displays 

from a pre-loaded table. 
7. TCRIT Association: 
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8. Target Size:   
9. Circular / Radius:  
10. Rectangular / Length, Width, Attitude: 
11. Activity Type: 
12. Target Location: 
13. Nomination Location: 
14. Speed of movement (KPH): 
15. Target Course (DEG): 
16. Target Priority: 
17. Number of Target Elements: 
18. Target Report Accuracy (M): 
19. Degree Of Personnel Protection:  UNK is default 
20. Personnel Clothing and Mask Indicator:  A is default. 
21. Text Indicator: 
22. Free Text: 
23. Downgrading/Declassification Markings: 
 
Step 8:  Click “Send” button. 
 
 
Generating and releasing a TIDAT  
message from a database query:   Back to Top 
 
Step 1:  Select “Database Query Operations” from Common Functions. 
 
Step 2:  Perform a database query. 
 
Step 3:  Select desired entity from the results window. 
 
Step 5:  Select “Generate Message” from the Selected pull down. 
 
Step 6:  Select “Target Nomination”. 
 
Step 7:  Review message and fill in appropriate data. 
 
Step 8:  Send message. 
 
 
Request an External Database Coordination 
(EDC) Message:        Back to Top 
 
Step 1:  On the toolbar, select the DBM button. 
 
Step 2:  Select “Request EDC From”. 
 
Step 3: Click the "New Source" button. 
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Step 4: Select the system you wish to receive EDC information from.  Press 
Done. 
 
Step 5: Select the new Source by clicking on it.  It will then be highlighted. 
 
Step 6: Edit the update rate.  The default rate is 20 min. This is the interval 
between automatic generations of EDC INTREPs.  Do not make the interval too 
short, especially if you have multiple subscribers.  The continual generation of 
INTREPs will slow down your system. 
 
Step 7: Select "Apply". 
 
Step 8: Highlight entry, Click on the Request for Information (RI) Criteria button. 
 
Step 9: Under criteria sets, highlight field to update record. 
 
Step 10: Under "Selected", choose one of the following selections: 

a.  "Auto Forward All".  This will forward all data to the ASCDB upon 
receipt.  In this manner old data is deleted or updated.  New data is 
added.  All of these events are tied to the Master Key value assigned to 
each record.   The master key is simply a unique serial number tracking 
device assigned to each record in the database.  The first two characters 
of the Master Key are the Source Enclave Code for the system, which 
originally created the record. Some units may choose not to auto-forward 
to keep local databases and EDC databases separate.  Consult your unit 
SOP for guidance.  We will auto-forward all information for the purposes of 
training.  
b. Auto Forward by Criteria.  This will only forward that data which fit your 
criteria.  When you select this option, a window will pop up. 
c.  Auto Forward Off.  This will keep all information in your EDC database, 
but keep it out of your ASCDB.  

 
Step 11: Highlight source again. 
 
Step 12: Under the Named Area, fill in the area of interest fields (LL/UR), if 
desired. 
 
Step 13: Under Time, fill in the Time Frame fields (start/stop DTG's) or Last 
Hours, if desired. 
Step 14: Select entity type- default is All Entities.  If you select all entities, only 
the allegiance field can be completed.  If you select unit, facility, or equipment all 
fields will be active.  Enter information for either the organization type and 
echelon range or the entity code.  Wildcards are allowed. 
 
Step 15: Select apply, the criteria resume fills out with your selections. 
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Step 16: Under criteria sets, select “New” to add more criteria for the source. 
 
Step 17: Select done. 
 
Step 18: Highlight the entry.        
 
Step 19: Click the "Send RI" button.  A RI message is then sent to the receiver’s 
ICM in-box. 
 
    
Connect Accessing the WWW Browser:  Back to Top 
 
Step 1.  From the Common Functions menu, select the Access WWW button. 
This opens the Netscape introduction page or the ASAS Home page. 
 
Step 2.  Select the Home button if the Netscape introduction page is displayed 
first. 
 
Step 3.  Click highlighted words (colored or underlined) in a page to bring another 
page of related information to your screen. To display the content you seek, 
you’ll need connections to those pages.  Well-crafted pages provide built-in 
connections (links) to other pages.  These connections are presented as 
highlighted words, pictures, or menu links.  Each link contains Internet location 
information that serves as an address of the web site. 
 
 
Create Graphic Intelligence Summary and  
post to the User's Home Page:    Back to Top 
 
 
Step 1 Select the Intelligence Product menu from either the SIT FI main menu 
or from the Top level banner under CDR Apps (Commander Applications).  This 
will bring up the INTEL PRODUCTS operations window.  If products already exist 
in the database, they will be listed in this window. They can then be selected by 
double clicking the product and displayed with commercial imagery software 
called Electronic Light Table (ELT3000).  
 
Step 2 The first pull down menu under intel products is the File Menu.   This 
contains the commands to create an image from your ASAS RWS or to 
download images from an organization. 

 
(a) Create: This allows you to capture a window or the entire screen to a 
graphics file.  It will display a list of active windows that are open on your 
system.  Select the "(TEM MAP) MAP." Upon selection, click on capture. 
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(b) Capture:  After selecting "Capture", the capture window appears.  On 
the 3rd line down, type in the name you want to give your graphic intsum.  
I.E., Joe.ntf.  Check "Additional GIF Version"  and hit "OK."  The capture 
button will start the capture all of the exposed map that you have opened.  
 
(c)  Two windows will appear.  On the large window, select file and quit.  
Then click on "OK" to quit when asked again.   
 
(d)  Select done on the "Capture" window. 
 
(e)  Select done on the "Intel Products" window. 
 
(f)  Select "Common Functions" pull down and select "Access WWW." 
 
(g)  Select "Intel Unit Website." 
 
(h)  Select "All Source Analysis."  
 
(i)  Select "Graphic Intsum." 
 
(j)  Select your name.GIF to open your Graphic Intsum.   Your NTF will not 
be able to open.    
 

 
 


